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reserved. No part of this document may be reproduced or transmitted in any form or by any
means, electronic or mechanical, or translated into another language, without the prior written
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Overview

Overview

This guide provides the information that you need to install Deltek Vision Connect for Microsoft
Outlook (1.0.32.8) for Vision 6.1 SP4 on your Vision Web server and install, implement, and
configure it on users' workstations.

This guide includes the following information:
=  Software requirements necessary to use Connect for Microsoft Outlook.
=  Security considerations.

= Information for users who are migrating from Deltek Vision Synchronization Server to
Connect for Microsoft Outlook.

= Instructions to download and install Connect for Microsoft Outlook on your Vision Web server.

=  Global configuration steps that a Vision system administrator must complete before installing
Connect for Microsoft Outlook on users' workstations.

= Instructions to install and configure Connect for Microsoft Outlook on users' workstations.

= Instructions to uninstall and upgrade Connect for Microsoft Outlook on users' workstations.

“.] The "Summary of Installation and Configuration Steps" section on page 20 provides a list of steps in
the order that is required to implement Connect for Microsoft Outlook.

What Is Deltek Vision Connect for Microsoft Outlook?

Deltek Vision Connect for Microsoft Outlook is add-in software that allows you to perform
important and common Vision tasks directly in Microsoft Outlook.

You can manage Vision business appointments, email messages, and contacts, as well as Vision
clients, activities, and opportunities, all from Outlook.

After you install and configure Connect for Microsoft Outlook, when you open Outlook, Connect
for Microsoft Outlook functionality is included in Outlook.

When you use Connect for Microsoft Outlook, you have the full functionality of Outlook as well as
the following Vision functionality:

= Activity management — You can create and manage Vision activities, calendar items, and
tasks and link them to Vision client, contact, employee, opportunity, or project records.

= Contact, client, and vendor management — You can add or modify Vision contacts,
clients, and vendors and link them to other Vision records.

= Email message management — You can create and manage email messages related to
Vision and link them to Vision records.

= Opportunity management — You can manage Vision opportunities and related information.

= Employee and Project reference — You can associate Vision employees and projects to
other Vision records.

Connect for Microsoft Outlook provides you with the following capabilities:

= Bi-directional synchronization — The incremental and bi-directional synchronization
process ensures that information between Connect for Microsoft Outlook and the Vision
application stays up-to-date and consistent. You can set up a schedule for synchronization to
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occur at a regular time interval. You also have the option to perform a synchronization
manually at any time.

= Disconnected support — You can work with Vision data in Outlook even when you are
disconnected from the Vision database.

@,  Connect for Microsoft Outlook is a Vision application that you purchase separately from the core
Vision software. Contact your Deltek representative for more information about purchasing Connect
for Microsoft Outlook if you do not already own it.

Connect for Microsoft Outlook Documentation

Terminology

In the Connect for Microsoft Outlook documentation, when we refer to Connect for Microsoft
Outlook, we are referring to opening Outlook with the Vision Connect for Microsoft Outlook add-in
software installed.

Online Help

After you install and configure Connect for Microsoft Outlook on a workstation, you can access
the Connect for Microsoft Outlook online help by clicking Help » Connect for Microsoft Outlook
on the Outlook menu bar in Connect for Microsoft Outlook.

(> Inbox- Microsoft Gutlook
File  Edit  Wiew Go  Tools  Adion Help Type

A Mew - Q,u _’: by ! 4 Rey 7 ﬁicrosoftOfﬁce Qutloak Help F1

% Snaglt [&' | Window - Microsaft Office Cnline

ive v %% | [} Searchaddressbooks - | @)

Contact U
& contact | 43 Client ¥ Opportunity 3 e ——
= Check for Updates
Folder List (= Disabled Items
All Folders 2 N
E ER  Office Diagnostics...
2] ANl Outlook e ms - || ar Activate Produdt
= €5t Mailbox B - '
__QJ ctivities Privaoy Options...
+ j Calendar About Microsoft Office Outlook
&= Clients .
&3 Contacts E Connect for Microsoft Qutlook Help

4 (3 Deleted Items [29]

The Connect for Microsoft Outlook online help:

= Provides information on how to use Connect for Microsoft Outlook and how to modify
Connect for Microsoft Outlook configuration settings after you initially set them up.

= Is accessible when you have Connect for Microsoft Outlook either online or offline.

Microsoft Outlook 2007

The Connect for Microsoft Outlook documentation is based on Microsoft Outlook 2007, unless
otherwise noted. Screen shots are taken with Microsoft Outlook 2007.
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If You Need Assistance

If You Need Assistance

If you need assistance installing, implementing, or using Connect for Microsoft Outlook, Deltek
has a wealth of information and expertise readily available to you.

Customer Services

For over 20 years, Deltek has maintained close relationships with client firms, helping with their
problems, listening to their needs, and getting to know their individual business environments. A
full range of customer services has grown out of this close contact, including the following:

=  Extensive self-support options through the Customer Care Connect Web portal
=  Phone and email support from Customer Care analysts

= Technical services

= Consulting services

= Custom programming

= Classroom, on-site, and Web-based training

Find out more about these and other services from the Customer Care Connect site at
https://support.deltek.com.

Customer Care Connect Site

The Deltek Customer Care Connect site is a support Web portal for Deltek customers who
purchase an Ongoing Support Plan (OSP).

The following are some of the many options you have at the Customer Care Connect site:
= Download the latest versions of your Deltek products
= Search Deltek’s knowledge base

= Ask questions, exchange ideas, and share knowledge with other Deltek customers through
the Deltek Connect Customer Forums

= Display or download product information, such as release notes, user guides, technical
information, and white papers

= Submit a support case and check on its progress

= Transfer requested files to a Customer Care analyst

= Use Quick Chat to submit a question to a Customer Care analyst online

= Subscribe to Deltek communications about your Deltek products and services

= Receive alerts of new Deltek releases and hot fixes

“&J If you need assistance using the Customer Care Connect site, the online help available on the site
provides answers for most questions.
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Access Customer Care Connect

To access the Customer Care Connect site, complete the following steps:

1. Go to https://support.deltek.com.

2. Enter your Customer Care Connect Username and Password.
3. Click Log In.
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Software Requirements

Software Requirements

You must have the following software installed before you install and use Vision Connect for
Microsoft Outlook:

Supported operating systems installed on workstations:

=  Microsoft Windows Professional XP SP3, 32-bit or 64-bit (x64)
= Microsoft Windows Vista SP2, 32-bit or 64-bit (x64)

= Microsoft Windows 7, 32-bit or 64-bit (x64)

Supported Microsoft Office versions installed on workstations:
= Microsoft Office 2003 SP3

= Microsoft Office 2007 SP2

= Microsoft Office 2010 (32-bit version only)

“&J Microsoft Office 2010 products are available in 64-bit versions. However, for the best productivity
and user experience, Microsoft recommends 32-bit Office 2010 for both 32-bit and 64-bit operating
systems. Office 2010 64-bit is optimized for advanced data analysis scenarios that most users do
not require, and existing 32-bit add-ins are not supported on Office 64-bit.

For more information about Office 2010 64-bit, see the following Microsoft Web page:

http://office.microsoft.com/en-us/products/office-2010-frequently-asked-questions-
HA101674631.aspx#About Office 2010 4.

Supported Microsoft Outlook versions installed on workstations:
= Microsoft Outlook 2003 SP3

= Microsoft Outlook 2007 SP2

= Microsoft Outlook 2010 (32-bit version only)

Supported Microsoft Exchange Server versions installed on your email server:
= Microsoft Exchange Server 2003 SP2, Cached Exchange Mode only

= Microsoft Exchange Server 2007 SP2, Cached Exchange Mode only

= Microsoft Exchange Server 2010, Cached Exchange Mode only

Installation Guide 5
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Supported Microsoft Outlook Configurations

Outlook Profiles and Default Email Delivery Location
You can install Connect for Microsoft Outlook only once for each user's Windows profile.

You can install Connect for Microsoft Outlook to only one Outlook profile. Connect for Microsoft
Outlook uses one specified Outlook profile as the default email delivery location to store Vision
data in Outlook on a user's workstation.

Connect for Microsoft Outlook supports either of the following for the default email delivery
location:

= A Microsoft Exchange mailbox — Connect for Microsoft Outlook data is stored on the
Exchange server and in the corresponding offline storage table (.OST) file on a user's
workstation.

= SMTP or POP3 email service — The default email delivery location is an Outlook personal
storage table (.PST) file on a user's workstation.

/’.\ IMAP storage is not supported. You cannot install Connect for Microsoft Outlook in the IMAP
— storage in Outlook.

/;\ You can install Connect for Microsoft Outlook only once per mailbox. You cannot install it to the

—— same user mailbox on multiple workstations or profiles. For example, you cannot install Connect for
Microsoft Outlook on both your laptop and desktop machines. If you do, you receive a data structure
collision error when you install Connect for Microsoft Outlook on the other workstations.

Cached Mode Only

For Microsoft Exchange Server 2003, 2007, or 2010 mailboxes, Connect for Microsoft Outlook
must be installed on workstations running in cached mode. Cached mode utilizes local OST files
that have a similar file structure to PST files to store the cached Microsoft Exchange mailbox
data.
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Know more.
Do more.™

Unsupported Third-Party Outlook Add-Ins

Deltek does not support other third-party Outlook add-in software when you use Connect for

Microsoft Outlook. Other add-ins may slow performance or cause application crashes.

Known Incompatible Third-Party Add-Ins

Known third-party Outlook add-ins that are incompatible with Connect for Microsoft Outlook are:

= Adobe PDF — You receive an "Outlook experienced a serious problem with the

'‘pdfmoutlook’ add-in..." error message.

= Colligo — Outlook crashes.

= {Tunes — Outlook crashes.

= Kaspersky Outlook Anti-Spam Addin and Kaspersky Outlook Anti-Virus Addin — You

receive an application error when you synchronize Connect for Microsoft Outlook.
= Microsoft Outlook Connector — Outlook hangs when you switch the language.

=  Skype — Outlook remains in memory after closing.

Check for Third-Party Add-Ins Installed in Outlook

To check for third-party Outlook add-ins before you install Connect for Microsoft Outlook,
complete the following steps:

\ Trusted Publishers
Add-ins

Privacy Options <

E-mail Security

1. Open Outlook, and on the Outlook menu bar, click Tools » Trust Center.

add-ins are identified on the Add-ins screen.

Trust Center

2l

Attachment Handling

Automatic Download

Macro Security <

Programmatic Access

<

Add-ins
| |Location |Type
—ﬁﬂmﬂﬁ‘ﬁ)
G TGOk \..0p3.dll  COM Add-i

Jdindll COM Add-i
fice.dll  COM Add-i
ort.dll COM Add-i
MudIMLDLL COM Add-i

Microsoft Exchange Unified Messaging

Microsoft Office Communicator 2007 Add-in

Microsoft Office SharePoint Server Colleague Import Add-in
Microsoft Qutlook Mobile Service

‘W Cihop3.dil

COM Add-i
Microsoft Access Outlook Add-in for Data Collection and Publishing  C\...LK.DLL COM Add-i
Microsoft VBA for Outlook Addin ChADLL COM Add-i
\Wﬂt Office Cutlook Chins.dil COM Add-i
POFMOutlook Chanokdll COM Add-i
Snaglt Add-in Chndingdll COM Add-i
4 | 2]
Add-in: Connect for Microsoft Outlook
Fublisher: <Monex
Location: ChDocuments and Settings\JuliBertram\Application Data\Deltek\Connect for

Microsoft Outlook\bin\CRMDesktop3.dll

Description:  Connect for Microsoft Outlook, a Deltek online/offline integration client for
Microsoft Cutlook

r Apply macro security settings to installed add-ins

d Go... |

Manage: ICOM Add-ins

OK I Cancel

2. Onthe Trust Center dialog box, click Add-ins. Active, inactive, and disabled application
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Connect for Microsoft Outlook Add-Ins

The two add-ins that are installed when you install Connect for Microsoft Outlook are:
= Connect for Microsoft Outlook

= CRMDesktop Ribbon Helper

Microsoft Office 2007 Add-Ins

Microsoft Office 2007 installs the following COM (Component Object Model) add-ins by default:
=  Microsoft Access Outlook Add-in for Data Collection and Publishing

= Microsoft Exchange Unified Messaging

= Microsoft Office Groove Proxy for Outlook Add-in

=  Microsoft Office SharePoint Server Colleague Import Add-in

= Microsoft Office Outlook Mobile Service

= Microsoft VBA for Outlook Add-in

= OneNote Notes about Outlook Items

= Windows Search E-mail Indexer

Any COM add-ins listed in the Trust Center other than the Microsoft Office 2007 add-ins and
Connect for Microsoft Outlook add-ins are third-party software add-ins.

You must disable all of the add-ins from the above list of known incompatible third-party add-ins
that display in the Active Applications Add-ins section of the Trust Center Add-ins screen. After
that, if you still experience any crashes in Connect for Microsoft Outlook, disable the other
third-party add-ins.

Installation Guide 8



Delte

Unsupported Third-Party Outlook Add-Ins

Know more.
Do more.™

Disable Third-Party Add-Ins Installed in Outlook

To disable any third-party add-in listed in the Active Applications Add-ins section of the

Trust Center, complete the following steps:
1. Open Outlook, and on the Outlook menu bar, click Tools » Trust Center.
2. Onthe Trust Center dialog box, click Add-ins.

3. On the Trust Center Add-ins screen, be sure that COM Add-ins is selected
Manage field, and click Go beside this field.

in the

Location: Ch\Documents and Settings'JuliBertram\Application Data\Deltek\Connect for
Microsoft Outlook\bin\CRMDesktop3.dll

Description:  Connect for Microsoft Outlook, a Deltek online/offline integration client for
Microsoft Outlook

[~ Applymacs TR T I

Qnge COM Add-ins - Go.. >
oK I

Cancel

2]
Trusted Publish
rusted Publishers Add-ins
Add-ins
Mame | Location |Type
Privacy Options Active Application Add-ins
. . Connect for Microsoft Outlook Ch..op3.dll  COM Add-i
E-mail Security Microsoft Exchange Unified Messaging Chodindl  COM Add-i
Attachment Handlin Microsoft Office Communicator 2007 Add-in Chficedll COM Add-i
9 Microsoft Office SharePoint Server Colleague Import Add-in Chortdll COM Add-i
Automatic Download Microsoft Outlook Mobile Service ChLINLDLL COM Add-i
Macro Security Inactive Application Add-ins
CRMDesktop Ribbon Helper Chop3dll COM Add-i
Programmatic Access Microsoft Access Outlook Add-in for Data Collection and Publishing  C\...LE.DLL COM Add-i
Microsoft VBA for Outlook Addin Ch W ADLL COM Add-i
Disabled Application Add-ins
Microsoft Conferencing Add-in for Microsoft Office Outlook Mains.dll COM Add-i
PDFMOutlook ok.dll COM Add-i
Snaglt Add-in Chadin, COM Add-i
| | 2]
Add-in: Connect for Microsoft Outlook
Publisher: <Monex

4. Onthe COM Add-Ins dialog box, clear the check box for any non-Microsoft add-ins, and

click OK to save your changes. The Trust Center closes automatically.

COM Add-Ins ed |
Add-Ins available:
[ Microsoft Conferencing Add-in For Microsoft OFfice Outlook ﬂ
v Microsoft Exchange Unified Messaging Cancel |
W Microsoft Office Communicatar 2007 Add-in
W Microsoft Cffice SharePoint Server Colleague Import Add-in add |
v Microsoft Qutlook Mobile Service i
v Microsoft VEA For Outlook Addin
I POFMOUHaGk BEEE |
I Snaglt Add-in -

Location: Ci\Documents and Settingsh, \Application Data\DeltekiConnect For Microsoft OutlookibintCRM. ..

Load Behavior: Load ak Startup

When you click Tools » Trust Center » Add-ins again, you should now see any add-ins that you

disabled listed in the Disabled Application Add-ins section.
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Re-enable Connect for Microsoft Outlook Add-Ins

If the Connect for Microsoft Outlook add-ins become disabled, which can happen if a third-party
add-in causes Connect for Microsoft Outlook to crash, you must re-enable them.

To re-enable the Connect for Microsoft Outlook add-ins, complete the following steps:

1.

2
3.
4

© ©® N o

Open Outlook.
On the Outlook menu bar, click Tools » Trust Center.
On the Trust Center dialog box, click Add-ins.

On the Add-in screen, click Connect for Microsoft Outlook in the Disabled
Applications Add-in section of the box that lists all the add-ins.

From the drop-down list in the Manage field at the bottom of the screen, select Disabled
Add-ins and click Go.

21
Trusted Publish
rusted Publishers Add-ins
Add-ins
Name | Location =~ Type -
Privacy Optians Active Application Add-ins
) ) Microsoft Office Communicator 2007 Add-in Ch . fice.dll  COM Add-in
E-mail Security Micrasoft Office SharePoint Server Colleague Import Add-in Chootdll  COM Add-in
. Microsoft Exchange Unified Messaging Chdinadll COM Add-in
Attachment Handlin
g Microsoft Cutlook Mobile Service ChnINLDLL COM Add-in
Automatic Download
Inactive Application Add-ins
Macro Security Micrasoft Access Outlook Add-in for Data Collection and Publishing . LK.DLL COM Add-in
Microsoft VBA for Qutlook Addin G ADLL COM Add-in
Programmatic Access
Disabled Application Add-ins
CREMOeskton Bibban H Choop3.dil COM Add-in
Connect for Microsoft Qutlook Chop3dll COM Add-in
FOFRTOOIO O Chakedll COM Add-inT
Microsoft Conferencing Add-in for Microsoft Office Outlook Chinsdll COM Add-in;l
Add-in: Connect for Microsoft Outlook
Publisher: <Mone>
Location: Ch\Documents and Settings\JuliBertram\Application Data\Deltek\Connect for
Microsoft Cutlook\bin\CRMDesktop3.dll
Description:  Connect for Microsoft Cutlook, a Deltek online/offline integration client for
Microsoft Outlook
r Apply macro security settings to installed add-ins

oK I Cancel

On the Disabled Items dialog box, click the Enable button.
On the Add-ins screen, click OK.
Repeat steps 4-7 for the CRMDesktop Ribbon Helper add-in.

Close and reopen Outlook.
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Supported Deltek Configurations

Multiple Users Who Use the Same Workstation

When a user on a workstation installs Connect for Microsoft Outlook, it is installed into that
individual user's Windows local profile location for applications.

The Windows local profile location for applications is as follows for the different Windows
operating systems:

= For Windows 7 and Windows Vista, it is located in
C:\Users\<UserName>\Roaming\Deltek\Connect for Microsoft Outlook.

=  For Windows XP, it is located in C:\Documents and Settings\<UserName>\Deltek\Connect for
Microsoft Outlook.

Each individual user must complete a separate installation of Connect for Microsoft Outlook on
the shared workstation while logged in as themselves. The Connect for Microsoft Outlook
application is installed within each user’s profile and is visible only to the user who performed the
installation.

For example, Mary, Tom, and Larry share workstation A and log into it at different times of the
day. Mary logs into the workstation first and installs Connect for Microsoft Outlook and configures
it when she launches Outlook. If Mary browses to %AppData\Deltek\Connect For Microsoft
Outlook), she will see her installation of Connect for Microsoft Outlook. When Tom or Larry
eventually logs into the machine, neither of them will see Mary's installation. They must perform
their own installation of Connect for Microsoft Outlook on workstation A.

/’i Warning: Connect for Microsoft Outlook cannot be installed on multiple machines using Outlook
- profiles configured to the same mailbox. To install it on a single workstation, you must be logged
into that machine as the user account whose mailbox is being used. That user must be a member
of the local administrator group on that machine during the installation. Local administrator rights
are not needed after the installation.

If you install Connect for Microsoft Outlook on multiple machines using Outlook profiles
configured to the same mailbox, you can damage the mailbox customizations, which may be
time consuming to fix.

Users with Multiple Mail Profiles

When users install Connect for Microsoft Outlook on their workstations, a user's mailbox is
updated to accommodate the Vision data that will be accessed and manipulated from Microsoft
Outlook. Connect for Microsoft Outlook uses the Outlook Mail Profile to update the mailbox.

Occasionally, some users may have one Outlook mail profile configured to access their personal
email account (GMail, AOL, and so on) and another Outlook mail profile to access their corporate
(work) email account. If a user has used the Mail icon in the Windows Control Panel to create
multiple email profiles for different mailboxes, the Connect for Microsoft Outlook installation will
recognize the additional mail profiles and prompt the user to choose which profile to use. Connect
for Microsoft Outlook can be installed for only one Outlook Mail profile.

Languages
Currently, only the ENU (US English) language is supported.

Installation Guide 12



Deltek gowmore

Supported Deltek Configurations

Customization for User-Defined Fields and Synchronization

Deltek Global Services can perform the following types of customization for Connect for Microsoft
Outlook:

= Add user-defined fields or grids to the Connect for Microsoft Outlook forms (Activity,
Calendar, Client, Contact, Opportunity, Task, and Vendor forms).

= Add presets for synchronization filters. Presets allow you to select a pre-defined filter
configuration on the Synchronization Control Panel dialog box in Connect for Microsoft
Outlook. Thus, you avoid the complex task of building the correct filters from scratch.

=  Limit synchronization frequency for users.

=  Apply hidden synchronization filters. You can create a filter in the XML file that determines
the maximum set of records that users can synchronize. Any filter set by individual users
would be a subset of the hidden filter. For example, in the XML file you could set it up so that
users can synchronize opportunities only in their own organization. If a user sets up a filter
based on opportunity probability without including organizations, then the user could
synchronize only the opportunities in his or her own organization that match the probability
filter.

%.]  Microsoft Outlook has a technical limitation that allows a form to have only one rich-text field. If a
rich-text field already exists on a form, then you cannot add user-defined memo fields to the form as
rich-text fields. However, you can add user-defined memo fields as unlimited plain-text fields.

If a memo field is added to Connect for Microsoft Outlook as a plain-text field, then:
=  The memo field will contain HTML codes that control the format of the field in Vision.

= |f a user makes changes to the text in the memo field and the field was previously formatted in
Vision, this formatting may be lost. Any new text that you add to the memo field will not be
formatted.

Microsoft Outlook has a technical limitation that allows a form to have only one URL field. If a form
already contains a URL field, then URL user-defined fields must be added as plain-text fields. A
URL in a plain-text field will not contain a hyperlink to the URL.

If you have questions about user-defined fields, presets, and other customization, contact Deltek
Global Services.

Microsoft Office Desktop Integration (MODI)

The Outlook portion of MODI is disabled when you install Connect for Microsoft Outlook, but you
can use other parts of MODI.

Licensing

Connect for Microsoft Outlook is a Vision application that you purchase separately from the core
Vision software. Contact your Deltek representative for more information about purchasing
Connect for Microsoft Outlook.
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Non-Supported Environments

Mobile Devices

The Vision-only data fields from Connect for Microsoft Outlook are not available on mobile
devices. If you use a mobile device and you synchronize it with Connect for Microsoft Outlook-
enabled Outlook via Microsoft Exchange ActiveSync® or some other mechanism, Vision
contacts, calendar items, and tasks synchronize to your mobile device. However, only the native
(standard) Outlook data fields for those Vision records are synchronized.

The following fields do not synchronize from a mobile device to Connect for Microsoft Outlook:

= Business Address

= Home Address

= The Contact’s Client/Vendor Name (Outlook Company)

=  Job Title

The following native Outlook contact fields synchronize both to and from mobile devices:

Native Outlook Field that Synchronizes
Both To and From Mobile Devices

What Happens to this Field in Vision when
You Synchronize Connect for Microsoft
Outlook and Vision

Phone fields

Of the many phone fields in which you can
enter data, only five phones are brought into
Vision: Business, Business Fax, Mobile,
Home, and Pager.

If you remove a contact from your
synchronization filter and thus it is
automatically removed from Connect for
Microsoft Outlook, then you lose the data in
any other phone field in Vision.

Full Name

All subcomponents of the name synchronize
both ways.

The Title and Suffix fields (part of the full
name) are not brought into Vision.

The native Outlook suffix values (Jr., Sr., lll,
and so on) are different than the Vision values
(AIA, CPE, CPA, and so on).

Job Title

In Connect for Microsoft Outlook, the native
Outlook field, Job Title, has been replaced
with Title, a Vision custom control, in order to
provide a drop-down list with job titles. The
Job Title field is hidden, so the mobile device
synchronizes with that hidden field.
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What Happens to this Field in Vision when

Native Outlook Field that Synchronizes You Synchronize Connect for Microsoft
Both To and From Mobile Devices Outlook and Vision

Web page address and IM address fields These fields exist in native Outlook, but not in

If the record is removed from Connect for Vision, so they are not brought into Vision.

Microsoft Outlook because it no longer
matches your synchronization filter, the data in
these fields is removed from your mobile
device.

Email addresses Only E-mail is brought into Vision. E-mail 2
and E-mail 3 are not brought into Vision.

On a mobile device, you can edit a read-only native Outlook record. When you synchronize your
mobile device with Connect for Microsoft Outlook, the record that you edited will be updated in
Connect for Microsoft Outlook. But, when you synchronize Connect for Microsoft Outlook with
Vision, the update fails and a synchronization issue occurs.

i\ Limitations using ActiveSync in an Exchange 2003 Environment
The use of Connect for Microsoft Outlook with ActiveSync in an Exchange 2003 environment has a
significant technical limitation. The sync engine within ActiveSync in Exchange 2003 does not
properly recognize Connect for Microsoft Outlook-related data and objects. As a result, when
contact data is updated on a mobile device and then synchronized back to Outlook via ActiveSync,
it is no longer recognized by Connect for Microsoft Outlook. This can result in data loss. This
limitation applies only when you use ActiveSync within Exchange 2003. It does not apply when you
use ActiveSync within Exchange 2007 or Exchange 2010.

Outlook Web Access

Outlook Web Access (OWA) is part of Microsoft Exchange Server. The Vision-only data fields
from Connect for Microsoft Outlook are not available in Outlook Web Access.

/1 Warning: When you use Connect for Microsoft Outlook, the OWA for Exchange Server 2007
displays the hidden MAPI attributes of Contact folders and other Connect for Microsoft Outlook
objects. This is a Microsoft software defect; these hidden fields are not displayed in the full
Microsoft Outlook client. In OWA for Exchange Server 2007, users could accidentally delete or
modify the custom configurations made by the Connect for Microsoft Outlook installation in the
mailbox.

This defect potentially affects all Connect for Microsoft Outlook users who use OWA in Exchange
Server 2007. This problem does not occur in OWA for Microsoft Exchange Server 2003 or
Exchange Server 2010.

Microsoft has resolved this defect in rollup 2 or later for Microsoft Exchange Server 2007 SP3. The
Microsoft article related to this defect is http://support.microsoft.com/kb/2210042. (A sub contact
folder is still visible after you set the "PR_ATTR_HIDDEN" attribute to "True" in an Exchange Server
2007 environment.)
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Outlook Contact Folders Without the "Contact" Name

Only contacts stored in the default Outlook “Contacts” folder are synchronized. If you rename
your default Contacts folder, the contacts will not synchronize. Additionally, contacts stored within
a subfolder of the default Contacts folder are not synchronized.

Lotus Notes

Deltek does not support the use of Lotus Notes with Connect for Microsoft Outlook.

Microsoft Outlook Delegates

Deltek does not support the use of the Outlook Delegates feature with Connect for Microsoft
Outlook.

Delegates (other Outlook users) send Outlook items, such as meeting requests, on your behalf.
For an explanation of how the Outlook Delegates feature works with Connect for Microsoft
Outlook, see the Outlook Delegate Access help topic in the Connect for Microsoft Outlook help.
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Vision Synchronization Server Migrations

The information in this section applies only if you currently use Vision Synchronization Server and
are migrating to Connect for Microsoft Outlook.

When you activate the Connect for Microsoft Outlook module in Vision Configuration » Module
Activation, the Vision Synchronization Server module is automatically disabled, preventing future
IntelliSynch Mobile Suite (IMS) synchronizations. You do not need to uninstall the
Synchronization Server software.

A system administrator must complete additional steps for a Connect for Microsoft Outlook
implementation so that the Vision contacts in a user's Outlook software (by way of
Synchronization Server) synchronize correctly and are not duplicated within Connect for Microsoft
Outlook.

f/’j\ You must complete the additional steps to prevent duplicate contacts before you activate the

£33 Connect for Microsoft Outlook module in Vision.

Required Steps to Prevent Duplicate Contact Records

A system administrator must complete the following steps before activating the Connect for
Microsoft Outlook module in Vision:

1. Run a script on the Vision server to add a DLTKSYNC category to contacts synchronized
by Vision Synchronization Server users.

2. Run afinal Synchronization Server synchronization to add the DLTKSYNC category to
Vision contacts in each user’s Outlook Contact folder. This category will be used to
identify the contacts for each user that are synchronized with Vision through the
Synchronization Server.

i

' If you configured Vision Synchronization Server for one-way synchronization only—from Microsoft
Outlook into Vision—or you do not use Synchronization Server but you manually imported your
Outlook contact records into Vision during a data migration from another software or via another
third-party product, you must add the DLTKSYNC category manually in Microsoft Outlook to the
contacts that have already been synchronized with Vision. You need to do this because in this
scenario, Vision is unable to send the category to Microsoft Outlook.

The "Summary of Installation and Configuration Steps" section on page 20 identifies the order of
the Connect for Microsoft Outlook installation and configuration steps, including the additional
steps for Synchronization Server migrations.

The specific instructions for performing the additional steps to prevent duplicate contacts are in
the "Synchronization Server and Other Migrations: Prevent Duplicate Contacts" section on page
29 of this guide.
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Synchronize Connect for Microsoft Outlook for the First Time

This section describes what to expect when you synchronize Connect for Microsoft Outlook for
the first time if you are migrating from Synchronization Server.

Contacts

During the first Connect for Microsoft Outlook synchronization, contacts that match your
synchronization filter criteria become shared contacts in Connect for Microsoft Outlook.
Shared with Vision

When you synchronize Connect for Microsoft Outlook for the first time, contacts are deleted from
Outlook and recreated in Connect for Microsoft Outlook as shared-with-Vision contacts if they
match your synchronization filters.

Shared contacts:

= Contain Vision-specific data fields not found in Outlook (for example the Client/Vendor field
on the Connect for Microsoft Outlook Contact form).

= Synchronize with Vision.

= Display in both Connect for Microsoft Outlook and Vision.

/’i‘\ Data that Does Not Synchronize with Connect for Microsoft Outlook

Any data in a contact field that was not synchronized with Vision through the Synchronization
Server is deleted.

For example, if a phone number is entered in the Car Phone field for a contact and this field was
not synchronized with Vision using Synchronization Server, then the phone number is permanently
deleted from the contact record.

Unshared with Vision

Contacts that were not synchronized previously with Vision through Synchronization Server
remain in Connect for Microsoft Outlook as unshared contacts.

Unshared contacts:

= Contain Vision-specific data fields that are not available in Outlook (for example the
Client/Vendor field on the Connect for Microsoft Outlook Contact form).

= Are not synchronized with Vision. They display in Connect for Microsoft Outlook only.

= Can be shared with Vision on a contact-by-contact basis at any time by clicking the Shared
with Deltek bar for the contact on the Contact form in Connect for Microsoft Outlook.
Tasks and Calendar Items

During the first Connect for Microsoft Outlook synchronization, tasks and calendar items are
converted to be shared or unshared with Vision.

Installation Guide 18



Deltek gowmore

Vision Synchronization Server Migrations

Shared with Vision

A shared task or calendar item can be associated with a Vision record, and it is synchronized with
Vision.

Task and calendar items are converted to shared-with-Vision records in Connect for Microsoft
Outlook if the task or calendar items meet the user's synchronization filter requirements during
the first Connect for Microsoft Outlook synchronization.

Unshared with Vision

Tasks and calendar items are converted to unshared-with-Vision records if no corresponding
activity for them is brought over to Connect for Microsoft Outlook when you synchronize for the
first time.

Example:

By default, the filter for the initial Connect for Microsoft Outlook synchronization includes all
activities from today’s date into the future. There were two meetings synchronized previously with
Synchronization Server—one occurring today and one that occurred yesterday. Today’s meeting
will be shared, but yesterday’s meeting will be unshared because there is no corresponding
activity for it in Connect for Microsoft Outlook.
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Summary of Installation and Configuration Steps

After you install the required software identified in the “System Requirements” section on page 5
of this guide, complete the following steps in the order listed to install and configure Vision
Connect for Microsoft Outlook. The specific instructions for each step are included in the
remaining sections of this guide. These sections include steps to perform on your Vision Web
server and steps to perform on end users' workstations.

These instructions apply to new Connect for Microsoft Outlook users. If you are an existing user
who needs to upgrade from an earlier version of Connect for Microsoft Outlook to the latest
version, see the "Upgrade Connect for Microsoft Outlook for Existing Users" subsection in the
"Download and Install Connect for Microsoft Outlook onto Your Vision Web Server" on page 23
for instructions.

@]  You may want to print this "Summary of Installation and Configuration Steps" section to use as a
check list as you work through the remaining sections of the guide.

Step | Description Complete By Guide Section and Page

Steps to Perform on the Vision Web Server:

1 Install Vision 6.1 SP4 Hot Fix 028. System "Download and Install Connect

administrator for Microsoft Outlook onto
Your Vision Web Server" on
page 23.

2 Download and install Connect for System "Download and Install Connect
Microsoft Outlook onto your Vision administrator for Microsoft Outlook onto
Web server. Your Vision Web Server" on
If you have multiple Web servers, page 23.
complete this step for each server.

3 For Synchronization Server and System "Synchronization Server and
other Migrations only: Perform steps | administrator Other Migrations: Prevent
to prevent duplicate contact records. Duplicate Contacts" on page

29.
) You must complete the steps to prevent duplicate contact records before you activate
- the Connect for Microsoft Outlook module in Vision.

4 Activate the Connect for Microsoft System "Activate the Connect for

Outlook module. administrator Microsoft Outlook Module" on
page 31.

5 Select Vision fields (natural keys) System "Select Vision Fields that
that determine duplicate records administrator Determine Duplicate Records
during synchronization. (Duplicate Check Formulas)"

on page 32.
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Step | Description

| Complete By | Guide Section and Page

6 Specify where you want Vision System "Specify Where You Want
activities to display in Connect for administrator Vision Activities to Display" on
Microsoft Outlook. page 37.

7 Provide Connect for Microsoft System "Provide Security Access to
Outlook users with security access to | administrator Connect for Microsoft Outlook
download Connect for Microsoft Users" on page 40.

Outlook and access appropriate
applications and records.

8 Vision configuration settings are This occurs "Configuration Settings
updated to Connect for Microsoft automatically Passed from Vision to Connect
Outlook users' workstations when an | during the for Microsoft Outlook" on page
automatic or manual synchronization | synchronization | 44.
is performed on a workstation. process.

Steps to Perform on End Users' Workstations:

9 Back up your Outlook data. Connect for "Back Up Your Outlook Data"

Microsoft on page 45.
Outlook user
10 Download and install Connect for Connect for "Download and Install Connect

Microsoft Outlook on a single
workstation with Vision Ultilities.

or

Download and install Connect for
Microsoft Outlook for multiple users
via Microsoft Systems Management
Server (SMS) or Group Policy with
optional pre-configuration
parameters.

or

Download and Install Connect for
Microsoft Outlook on multiple
workstations using Microsoft SMS or
Group Policy. (Sample deployment
Steps are provided.)

Microsoft
Outlook user

System
administrator

System
administrator

for Microsoft Outlook on a
Workstation Using Vision
Utilities" on page 46.

"Use Command Line
Parameters To Deploy
Connect for Microsoft Outlook
on Multiple Workstations" on
page 51.

"Download and Install Connect
for Microsoft Outlook on
Multiple Workstations Using
Microsoft SMS or Group
Policy" on page 54.

o

Warning: Connect for Microsoft Outlook cannot be installed on multiple machines
using Outlook profiles configured to the same mailbox. To install it on a single

workstation, you must be logged into that machine as the user account whose mailbox
is being used. That user must be a member of the local administrator group on that
machine during the installation. Local administrator rights are not needed after the

installation.

If you install Connect for Microsoft Outlook on multiple machines using Outlook
profiles configured to the same mailbox, you can damage the mailbox
customizations, which may be time consuming to fix.
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Description Complete By | Guide Section and Page
11 Perform steps to avoid duplicate Connect for "Avoid Duplicate Contact
contact records. Microsoft Records" on page 56.

Outlook user

,/,\ Deltek recommends that end users review this section before deploying Connect for
‘= Microsoft Outlook for the first time on their workstation.

12 Deploy the Connect for Microsoft Connect for "Deploy and Configure
Outlook software for the first time on | Microsoft Microsoft Outlook for the First
a workstation and use the Connect Outlook user Time" on page 57.
for Microsoft Outlook Assistant to
configure it.

/,\ Deltek recommends that you stagger the initial Connect for Microsoft Outlook

‘—* implementation so that a significant number of users are not performing the initial
synchronization all at the same time. This will help prevent overloading your system
(Vision and email) with potentially large numbers of records and data being
synchronized during the first synchronization. Users perform the initial synchronization
when they complete the Connect for Microsoft Outlook Assistant, as described in the
"Deploy and Configure Connect for Microsoft Outlook for the First Time" section of the
guide.

For more information about synchronization schedules and automatic synchronization
after the initial synchronization, see "Appendix C: Synchronization Schedules" on page

113.
13 Check for and resolve duplicate Connect for "Check and Resolve Duplicate
contact records. Microsoft Contact Records" on page 72.
Outlook user

The "Access and Use Connect for Microsoft Outlook" section on page 74 of this guide will help you
get started using Connect for Microsoft Outlook. It tells you where to find the Vision Connect for
Microsoft functionality within Outlook.

For more specific instructions on how to use the Connect for Microsoft Outlook software, see the
online help in Connect for Microsoft Outlook. To access the help, click Help » Connect for
Microsoft Outlook on the Outlook menu bar in Connect for Microsoft Outlook.

The online help also provides instructions on how to modify your Connect for Microsoft Outlook
configuration settings. The help is accessible when Connect for Microsoft Outlook is either online or
offline.
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Download and Install Connect for Microsoft
Outlook onto Your Vision Web Server

Use these instructions to download and install Deltek Connect for Microsoft Outlook (1.0.32.8) for
Vision 6.1 SP4 onto your Vision Web server. If you have multiple Web servers, you must perform
the installation on each Web server.

Because Internet Information Services (1IS) will be stopped and all users will be disconnected
when you install Connect for Microsoft Outlook on your Vision Web server, Deltek recommends
that you install this after your usual work hours when users are not logged on to Vision. If you do
the installation during normal work hours, let users know about the system down time.

Installing Connect for Microsoft Outlook for New Users

The information in this section applies if you do not currently have Connect for Microsoft Outlook
installed, and you are installing it for the first time.

3

/1% You must download and install Vision 6.1 SP4 Hot Fix 028 (the most current release) before you
—  complete the steps in the "Download and Install Connect for Microsoft Outlook" section on page 24.

You can download and install Vision 6.1 SP4 Hot Fix 028 from the Product Download tab at the
Deltek Customer Care Connect site.

After you download and install Vision 6.1 SP4 Hot Fix 028, follow the instructions on page 24 to
download and install Connect for Microsoft Outlook (1.0.32.8) for Vision 6.1 SP4 onto your Vision
Web server.

Upgrading Connect for Microsoft Outlook for Existing Users

The information in this section applies if you currently have Connect for Microsoft Outlook
installed, and you are upgrading to Connect for Microsoft Outlook (1.0.32.8) for Vision 6.1 SP4.

Connect for Microsoft Outlook does not support in-place upgrades on end-user workstations. To
upgrade the Connect for Microsoft Outlook application, you must complete the following steps
in the order listed:

1. Uninstall Connect for Microsoft Outlook (build 1.0.27.0 and earlier) from end-user
workstations.

3 If you update the server with new Connect for Microsoft Outlook software before

& uninstalling the old Connect for Microsoft Outlook version on users’ workstations, when
users open their older versions of Connect for Microsoft Outlook, they will be prompted to
apply changes from the new update to their workstations. In this scenario, users should
select No. If they select Yes to make the changes, this can potentially cause problems
when uninstalling from the workstation.

If a user selects Yes to make the changes, when you review the application logs in the
%AppData%)\Deltek\Connect For Microsoft Outlook folder on the workstation, the log will
indicate that the version on the server is newer than the current version being run on the
workstation.
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For instructions on how to uninstall Connect for Microsoft Outlook on workstations, see
the following sections of this guide:

= "Uninstall Connect for Microsoft Outlook for a Single User" on page 84.
= "Uninstall Connect for Microsoft Outlook Using Microsoft SMS" on page 86.

Log onto your Vision Web server, and download and install Vision 6.1 SP4 Hot Fix 028
(the most current release).

You can download and install Vision 6.1 SP4 Hot Fix 028 from the Product Download tab
at the Deltek Customer Care Connect site.

At the database update screen, apply the database changes to all databases that you
use with Connect for Microsoft Outlook.

Install the Connect for Microsoft Outlook (1.0.32.8) for Vision 6.1 SP4 on your Web
server.

Follow the instructions for this in the "Download and Install Connect for Microsoft
Outlook" section on page 24.

/’;\\ You must download and install Vision 6.1 SP4 Hot Fix 028 (per step 2) before you
‘= complete the steps in the "Download and Install Connect for Microsoft Outlook" section.

Re-install Connect for Microsoft Outlook on end-user workstations.

For instructions on installing Connect for Microsoft Outlook on end-user workstations, see
the following sections of this guide:

= Download and Install Connect for Microsoft Outlook on a Workstation Using Vision
Utilities on page 46.

= Use Command Line Parameters To Deploy Connect for Microsoft Outlook on Multiple
Workstations on page 51.

= Download and Install Connect for Microsoft Outlook on Multiple Workstations Using
Microsoft SMS or Group Policy on page 54.

Download and Install Connect for Microsoft Outlook

/’,} The following instructions apply to both new and existing Connect for Microsoft Outlook users.

Before you complete these instructions, be sure that you have completed the appropriate
procedures in the "Installing Connect for Microsoft Outlook for New Users" or "Upgrading Connect
for Microsoft Outlook for Existing Users" sections on page 23.

To download and install Connect for Microsoft Outlook (1.0.32.8) for Vision 6.1 SP4 on
your Vision Web server, complete the following steps:

1.

2
3.
4

Log on to your Vision Web server.

Open the Deltek Customer Care Connect Web site.

On the Product Download tab, click Run Deltek Software Manager.

On the Deltek Software Manager screen, navigate to Vision 6.1 (SP4) in the pane on the
left side of the screen.
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Click the plus sign beside Vision 6.1 (SP4), and then click Sub-Release from the
expanded list.

In the expanded grid, click the Deltek Connect for Microsoft Outlook (G check box to
add it to the Download Queue.

Click the Download button in the bottom left corner of the Deltek Software Manager
screen. This downloads the DeltekConnectForMicrosoftOutlookGAfor61SP4.exe file
(a self-extracting utility) and documentation files to C:\Documents and Settings\<user
name>\Desktop\Deltek Software Downloads. You can view or edit the default location by
clicking Settings in the upper right corner of the Deltek Software Manager screen.

When this finishes, click Close in the Download Process dialog box.

On your Desktop, click the Deltek Software Downloads folder.

. Double-click the Vision folder » 61 folder » SP4 folder » GA folder »

DeltekConnectForMicrosoftOutlookGAfor61SP4.exe file.

A setup wizard that extracts the installation package is launched.

Deltek - InstallShield Wizard ) o ] |
— =
Preparing Setup W
Please wait while the InstallShield \Wizard prepares the setup. I -

Deltek Setup iz preparing the InstallShield *Wizard, which will guide you through the rest of the
zetup process. Pleasze wait.

IrztallShield

Cancel

(f' The setup process verifies that you have Vision 6.1 SP4 with the most current hot fix
installed before it continues. If you do not have the most current hot fix installed, you are
instructed to install it first, and then re-rerun the Connect for Microsoft Outlook installation.
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11. On the Welcome page, click Next to continue.

Deltek Vision HotFix Installation Wizard

‘Welcome to the Delek Vision 6.1 [SP4) Hot Fix
Installation Wizard

Delek. Conrect For Mictosof!l Outlook - General Availabdity

¢ Back W Cancel I

Internet Information Services (11S) stops and all users are disconnected.

@ Stopping Internet Information Server...

12. On the Ready to Install page, click Install to update your database, and install the
software on your Vision Web server.

Deltek ¥ision HotFix Installation Wizard
FReady to Install

Click Install to beqin the installation.

If wou want to review or change any of your installation settings, click Back. Click Cancel to exit
the wizard.

[mztallShield

< Back

Cancel
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13. On the Deltek Vision 6.1 (SP4) Hot Fix Wizard Complete page, click Finish.
D&Itgl_ﬁ_}l_’rs_i_t_-_n HotFix Insta I!l-_g_tion Wizard A

Delek Vision 6.1 [SP4) Hot Fix Wizard Complete

The Dedtek Vision hot s wizard has successhuly patched this
compuibed.

HotFix Installed: Delek Connect For Microsoft Dutoolk -

14. When you installed the latest Vision 6.1 SP4 hot fix, if you did not choose to apply the conversion
script, you must complete the following steps to apply the conversion update script now.

/’g\ If you do not apply the script, Connect for Microsoft Outlook users may encounter various
— ‘"Internal Error" messages during synchronization.

“.] When you installed the latest Vision hot fix, if the installer detected that a database
upgrade script needed to be applied to your database, the upgrade wizard gave you the
option to automatically back up your database and apply the database update script. If you
did not automatically apply the database changes and, instead, you selected the | will
backup and upgrade the database myself after the installation check box, you were
instructed to upgrade the databases before users accessed them in order to avoid errors.
The upgrade script is located in C:\Program Files (x86)\Deltek\Vision\Databases\Scripts
folder.

To apply the update conversion script now, complete the following steps:
a. Make a manual backup of your database.

b. Launch Weblink, and enter the Weblink password.

c. Click the Database Grid View tab.
d

Select the check box in the Select column for the database you are applying the
script against.
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Weblink

4w Save B Change Pessword Dhelete O Cratabases (7 Help

Geneal Repust Server System Setlings Dalabave GridView

Grid View = it SeletAll X Delete & Up. 3 Down
Seled. | Desuiption Disalle Provess Server | Disalde Sync Server Feport Serves URL Windums Username | Windows Pesswond,  Server Name Dal
L1 el Visiun (MGVM-KERT) = v http/MEVM-KERD reportuer | DellekVimion . MGVM-KER2 Rep

BN

lé' - - il

Select the Select check box.

Scripts in C \Prograr Filos (B8 j0ollskVison Databasts\Saipls, -+ o, RunSoipls & bsed |

file Name
B[ Dieltelevisinng SPIHetF_ 00snl

\ Enter DeltekVision61SP4HotFix028.sql.

sf & & 1l [

e. Inthe File Name field in the Scripts in ... grid, enter

Copy 2. Dolotn

3 Tz
PR .

DeltekVision61SP4HotFix028.sql, and then click the Run Scripts icon on the grid

toolbar to execute the script.

Weblink will detect whether or not your database is Unicode. It will automatically
execute the DeltekVision61SP4HotFix028.sql script as Unicode against a Unicode

database.
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Synchronization Server and Other Migrations:
Prevent Duplicate Contacts

Follow the instructions in this section if either of the following apply:

= You currently use Vision Synchronization Server with two-way or one-way data
synchronization, and you are migrating to Connect for Microsoft Outlook.

= You do not use Synchronization Server but you manually imported Microsoft Outlook contact
records into Vision during a data migration from another software or via another third-party
product.

If these do not apply, you can skip the instructions in this section.

A n

&

You must complete these steps to prevent duplicate contacts from being created.

A system administrator must complete these steps before activating the Connect for
Microsoft Outlook module in Vision.

Back up your Microsoft Outlook data before you complete the steps in this section.
Backup instructions are on page 45 of this guide. If you have entered data in
Microsoft Outlook contact fields that do not exist in Vision (such as the Birthday and
Spouse/Partner fields), the content in these fields in Connect for Microsoft Outlook
may be removed when you synchronize Connect for Microsoft Outlook. For this
reason, we urge you to back up your Outlook data so you can view any missing data
if needed.

Eﬂl A summary of Synchronization Server migrations is provided on page 17 of this guide.

To prevent duplicate contacts from being created, complete the following steps:

1. Run a script on the Vision server to add a DLTKSYNC category to contacts in Vision.

To run the script, complete the following steps:

a. Loginto SQL Server Management Studio, and open a query window on the
Vision database.

b. Enter the script name getAllSyncContactsForAllEmployees.
c. Pressthe F5 key on your keyboard to execute the script.

d. The DLTKSYNC contact category is assigned to all contacts in the Vision
database.

2. Complete one of the following options that matches your situation:

If you currently use Synchronization Server with two-way data synchronization or
one-way synchronization from Vision to Outlook:

Run a final Synchronization Server synchronization so that the DLTKSYNC category
is added to Vision contacts in each user’s Outlook software. The category will be
used to identify the contacts for each user that are synchronized with Vision through
Synchronization Server.
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= If you currently use Synchronization Server with one-way synchronization from
Outlook to Vision or you manually imported Outlook contact records into Vision
during a data migration from another software or via another third-party product:

Vision is unable to send the DLTKSYNC category automatically to Outlook. To avoid
the duplication of contacts that were previously synchronized into Vision, you must
manually apply the DLTKSYNC category to the contact records in Outlook that you
know were previously synchronized to Vision.

Most users who perform one-way synchronization into Vision use a category filter to
allow only certain records to be synchronized into Vision. If that is the case, you can
group the contacts in Outlook by those categories and add an additional category
named DLTKSYNC to the category list.

The category will be used to identify the contacts for each user that are synchronized
with Vision through Synchronization Server.

& You must manually assign the DLTKSYNC category to only contacts that already
—} exist in Vision. Any contact that has a DLTKSYNC category in Outlook that does not
exist in Vision will be deleted from Outlook.

For either of the situations in step 2, when you follow step 16 in the "Deploy and
Configure Connect for Microsoft Outlook for the First Time" section on page 57, you must
select Yes in the following Confirm Outlook Contact Conversion dialog box:

Confirm Outlook Contact Conversion =l

Should the Connect For Microsoft utlook installation process convert existing Outlook, contacts to unshared business

? \
‘-'\/‘ conkacts?
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Activate Connect for Microsoft Outlook

After you download the Connect for Microsoft Outlook software to your Vision Web server, you
activate the Connect for Microsoft Outlook module.

When you activate Connect for Microsoft Outlook, if you have Vision Synchronization Server
= installed, it is automatically inactivated.

= For Synchronization Server migrations, you must perform the steps in the Synchronization
Server and Other Migrations: Prevent Duplicate Contacts section on page 29 before activating
the Connect for Microsoft Outlook module.

To activate the Connect for Microsoft Outlook module, a system administrator completes
the following steps:

1. On the Vision Applications menu, click Configuration » Module Activation.

2. On the Module Activation form, enter the password that Deltek assigned to your firm for
the Connect for Microsoft Outlook module.

3. Click OK to save.

8B Module Activation |

Please enter the client number assigned to your firm by Deltek, In addition, when you purchased your software, you
should have received passwords for each licensed module. Please enter these passwords below to gain access to the
system.

Client Number

Vision Modules ~
Module Password License

b | Project Control Enterprise: 3000
Accounting Enterprise: 3000
Billing Enterprise: 3000
Time Enterprise: 3000
Expense Enterprise: 3000
Payroll Enterprise: 3000
Resource Planning Enterprise: 3000
CRM Enterprise: 3000
Custom Proposals Enterprise: 3000
SF330/5F255/5F254 Proposals Enterprise: 3000
Payroll Interface Enterprise: 3000
Abra HR Interface Enterprise: 3000
Synchronization Server Invalid

. Multicurrency Enterprise: 3000
Purchasing Enterprise: 3000
Document Management Enterprise: 3000
Mobile Application Suite Enterprise: 3000
Performance Management Enterprise: 3000

linqual L S

< Connect ot Micnosof EOUEiookdi * -+ eieiiciiisroiirorsiokiioiikibh okl Enterprise: 3000 >

OK H Cancel ][ Help ]
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Select Vision Fields that Determine Duplicate
Records (Duplicate Check Formulas)

To prevent duplicate records from being created, you must select Vision database fields (natural
keys) that will be compared when information between Connect for Microsoft Outlook and Vision
is synchronized.

These database fields identify unique individual Vision client, contact, opportunity, and vendor
records so that the specific records are updated correctly as intended. This prevents data for two
different records from being merged together unintentionally when each record has the same
entry in one or more of its fields.

For example, for Vision contacts, if you choose the first name field and the last name field as the
fields to determine duplicate contacts, any contacts with the same first name and last name would
be considered as duplicate contacts (the same contact).

When Connect for Microsoft Outlook and Vision are synchronized, if duplicate records are found,
you have the following options:

=  Select one record to keep; the other record is deleted.

=  Merge the two records into one record.

“.]  You select the fields for determining duplicate clients, contacts, opportunity, and vendors. However,
the fields for determining duplicate activities are preset with the following fields:

=  ConversationID — This is an internal Vision field (not visible to users) that tracks the Outlook
internal ID for the record (or thread, if it is an email). It prevents duplicate activities from being
created if multiple people choose to share the same event or email.

=  Subject AND Start Date/Time AND Owner

These fields are checked against all other activities in Connect for Microsoft Outlook when you save
an activity. If another activity has the same content in these fields as the new activity that you
created, you receive a message telling you that the activity already exists. You cannot save
duplicate activities.

When you synchronize an activity, these fields are checked against all Vision records for a
duplicate.
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To select the Vision fields that determine duplicate records, a Vision system administrator
completes the following steps:

1. On the Vision Applications menu, click Configuration » General » Connect for
Microsoft Outlook.

On the Connect for Microsoft Outlook Configuration form, you see a separate grid for
Clients, Contacts, Opportunities, and Vendors. Complete the remaining steps for each
grid/record type. In these instructions, the Contact record is used as an example.

A Connect for Microsoft Outlook Configuration

rDetecting Duplicates
Clients ~ G5 Insert 7 Edit < Delete Contacts ~ G5 Insert # Edit X Delete
Duplicate Check Formulas Cond - Duplicate Check Formulas Cond
[Mame] OR [First Name] + [Last Mame] OR
[Cantacts.EMail] OR
Opporunities + G5 Insert 7 Edit X Delete Yendars 45 Insert # Edit X Delete
Duplicate Check Formulas Cond - Duplicate Check Formulas Caond
[Mame] OR [Mame] OR

2. Onagrid's toolbar, click Insert to open the Duplicate Check Formula dialog box and
select the fields for a duplicate check formula.

In the following example, duplicate check fields are being selected for contacts.
——— e ——

Contacts ~ & Insert ) Edit. X Delete

A

Duplicate Check Farmulas | Cond |
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3. Onthe Duplicate Check Formula dialog box, click Insert on the toolbar to insert a new
row in the grid.

Duplil:al:e Check Formula il
Fields Used in Duplicate Check ~ fj Insert.. 5. Delete
Field | Cond |
\\
| (84 | | Cancel | | Help |

4. Inthe new row, click E in the Field column, and from the drop-down list, select a field
to add to the duplicate check formula.

Duplicate Check Formula |
Fields Used in Duplicate Check - nf'g Insert )( Celete
Field Zond
b AMD
Ermail s
First Marne
Horne E
Last Marme
Middle Mame i
Ik | | Cancel | | Help

5. To add more fields to the formula, click Insert on the Duplicate Check Formula toolbar
and repeat step 4.

@ = You must select at least one field for a duplicate check formula.
=  There is no limit to the number of fields that you can add to a duplicate check formula.

=  The Cond column in the grid on the Duplicate Check Formula dialog box always
displays AND to indicate that an AND operator is used between the each field that you
add to the duplicate check formula.
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In the following example, we selected First Name from the Field drop-down list. Then,
we clicked Insert again, and selected Last Name from the Field drop-down list.

Duplicate Check Formula ﬂ
Fields Used in Duplicate Check - $3 Inset X Delete
Field Cond
First Marne ArD
Lask Mame AMD
(04 | | Carnicel | | Help

6. When you finish adding fields to a formula, click OK to return to the Connect for Microsoft
Outlook Configuration form.

The fields that comprise the duplicate check formula display in a row in the record grid.

Contacts ~ %= Insert 7 Edit X Delete
Duplicate Check Formulas Cond

| [First Mame] + [Lask Mame] R,

7. Repeat steps 2 through 6 to add another duplicate check formula.

%. = Each formula displays in a separate row in the record grid on the Connect for
Microsoft Outlook Configuration form.

=  When you create multiple duplicate check formulas for a record, the Cond column in
the grid on the Connect for Microsoft Outlook Configuration form always displays OR
to indicate that an OR operator is used between the each duplicate check formula.
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In the following example, we added another duplicate check formula that is comprised of

the Email field.

During synchronization, a duplicate contact is detected when multiple contacts have the
same first and last names or when their email address is the same.

Contacts -

%= Insert # Edit X Delete

Duplicate Check Formulas

[Firsk Mame] + [Lask Mame]
% [Ernail]

Separate
formulas in
each row

IR,
R,

With the OR operator,
duplicate records are
identified when records
match any one of the

b formulas in the grid;
N matching all the
formulas in the grid is
not required.

8. When you finish creating duplicate check formulas, click Save on the Connect for

Microsoft Outlook Configuration form toolbar.

To edit a duplicate check formula, complete the following steps:

1. Click anywhere in the duplicate check formula's row in

Microsoft Outlook Configuration form. The row selector
column to indicate that the row is selected.

Teﬂqrid on the Connect for

icon displays in the first

Contacts ~ %= Insert 7 Edit X Delete
Duplicate Check Farmulas Zond
[First Mame] + [Lask MName] QR
b | [Emnail] R,

2. Click Edit to open the Duplicate Check Formula dialog box and modify the formula.

To delete a duplicate check formula, complete the following steps:

1. Click anywhere in the duplicate check formula's row in the grid on the Connect for

Microsoft Outlook Configuration form. The row selector III icon displays in the first

column to indicate that the row is selected.

2. Click Delete on the grid toolbar. The formula/row is immediately deleted.
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Specify Where You Want Vision Activities to
Display

A Vision system administrator specifies where different types of Vision activities display in
Connect for Microsoft Outlook. Vision activity types include appointments, mailings, meetings,
tasks, and so on. You choose whether these display as calendar items, tasks, and/or items in the
Activity Manager only.

The Activities display setting:

= Applies for all Vision users.

= Determines where the activities display in the Vision software as well as in Connect for
Microsoft Outlook.

To determine where Vision activities display in Connect for Microsoft Outlook and Vision,
complete the following steps:

1. Open Vision, and on the Applications menu click Configuration » General » Code
Tables.

2. On the Code Table Maintenance form, click Activity Type in the Description column of
the Code table.

|" & Code Table Maintenance

= Print (2)
Code Tables -
| Diescription Table Mame e
Account Group Table Codes CFGAccountiaroupTableCode
Activity Subiect CFGAckivitySubject
b | Activity Tvpe ) CFGACkivity Type
Ming Fate Table Codes CFGEilingRateTableCode =
Client Relationship CFaClientCurrentStatus
Client Role CFGClientRole
Client ko Client Relationship CFGClientRelationship 8
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3. Inthe Display column on the Activity Type dialog box, select the location in which you
want each activity type to display.

Activity Type il

Activity Type — @./. | i \e g Ef'j Ingert ?{ Delete
Description / \ Code
b | EMail Activity Manager Only EMail
failing Ackivity Manager Only IMailing
Meeting Calendar Meeting
Merge Ackivity Manager Only Merge
Phone Call \ Calendar / Phane Call
Task \ Task / Task

w

Save | | Cancel |

The display locations are:
= Calendar
The calendar activity type displays in the following locations:
=  Vision Calendar
= Connect for Microsoft Outlook Calendar
= Vision Activity Manager
= Connect for Microsoft Outlook Activities folder
= Activity grids on the associated records in Vision
= Activity grids on the associated records in Connect for Microsoft Outlook
= Task
The task activity type displays in the following locations:
= Vision Calendar, when a user selects to view tasks
= Connect for Microsoft Outlook Task Folder
= Vision Activity Manager
= Connect for Microsoft Outlook Activities folder
= Activity grids on the associated records in Vision

= Activity grids on the associated records in Connect for Microsoft Outlook
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= Activity Manager Only

The activity-manager-only activity type displays in the following locations:

Vision Activity Manager
Connect for Microsoft Outlook Activities folder
Activity grids on the associated records in Vision

Activity grids on the associated records in Connect for Microsoft Outlook

4. When you finish, click Save.

Installation Guide

39



Deltek gowmore

Provide Security Access to Connect for Microsoft Outlook Users

Provide Security Access to Connect for Microsoft
Outlook Users

Vision security is applied directly in Connect for Microsoft Outlook.

The Vision security role assigned to Vision users determines:

= Whether or not a user can download Connect for Microsoft Outlook.

=  Which Vision applications and records are visible.

= The actions that users can perform with Vision records in Connect for Microsoft Outlook.

The Vision security role and screen designer settings described in this section allow users to
view, create, modify, delete, and associate Vision records in Vision as well as in Connect for
Microsoft Outlook.

A system administrator sets up security roles and their access rights in Vision Configuration »
Security » Roles. A system administrator assigns security roles to individual users in Vision
Configuration » Security » Users and Passwords.

Access to Download Connect for Microsoft Outlook

To be able to download Connect for Microsoft Outlook from Vision Utilities, a user’s security role
must have rights to access the Download Connect for Microsoft Outlook utility.

The setting to allow this access is in Vision Configuration » Security » Roles. In the menu items
access section on the General tab, select the Download Connect for Microsoft Outlook check
box under the Utilities menu.

| A Roles Find QI

" DeleteRole w=t Print +

DEFAULT
General |Record ArCcess | Accounting | Flanning |nccess Rights |
Role [ DEFALLT | [ Tvpe of Role
[ administratar
[T] Full access ta all menu items | Etablz Al | | Disable Al | Accounting
i 4 CRM
< = B Utilities
[I% Change Period —Favarites Organizing
LJ& Cpen New Period | Save For All Roles | & |
[[14%s Period Setup
[[14%% Open Mew Benefit Year N
[Jées Open Mew W-2 Quarter [ Process Queles
[J&s 1099 Initialization Allow priority {or higher}

14y User Activity L

<

L&y Advanced Utilties —Organization Record Access
LI&® key Conversians |P.II Organizations C'|
[Jés Key Formats Ca
[l Process Server
[[14y History Loading —Search Options

[[J% Backup Database [] Alow Access ko SOL Where Clause

[J&% Report Administration

[ Download Mergs Macro ["] Enable Searching Across Info Centers

[[14%s Download Integration
[ ey taabile Application Suite r—Email Template Crganizing

¥ Download Connect for Microsoft Gutlook ) | Save Personal Orly | = |

| | BT oA ormgar e [+]
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Access to Vision Applications

On the General tab in Vision Configuration » Security » Roles, you choose the applications that
a security role can access. This setting applies for access to applications to both Vision and
Connect for Microsoft Outlook.

For access to all possible Vision applications in Connect for Microsoft Outlook, on the General
tab, select the check box beside the following Vision applications to give full access to these
areas and their submenus:

= Info Centers
= Clients
= Contacts
= Opportunities
= Vendors
= Calendar/Activities

If you do not have access to an entire application, the corresponding folder for it does not display
in the Connect for Microsoft Outlook Folder List view of the Navigation pane. For example, if you
do not have access to Vision Vendors, a Vendor folder does not display in the Connect for
Microsoft Outlook Folder List view of the Navigation pane.

Access to Individual Records within Vision Applications

Vision security roles determine a user's access to individual records within Vision Clients,
Contacts, Opportunities, Vendors, and Activities. The settings that affect access to individual
records apply to both Vision and Connect for Microsoft Outlook.

A security role can have full rights, view-only, modify, or add/modify rights that allow users to
view, create, modify, delete, and associate Vision records.

The Vision security settings in Configuration » Security » Roles » Record Access tab that
affect individual record access are:

=  Application Record Access grid:
= The Record Level View column
=  The Access column, which applies to the Record Level Update column in the grid
= The Record Level Update column
= Activity Access section:
= The Record Level View field
= The Record Level Update field

Rights to update "Accounting Only" client and vendor addresses are controlled by the
Accounting check box in the Type of Role section of the General tab in Configuration »
Security » Roles.

[l;[l See the security section of the Vision online help for more information about these security settings.
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Deleting Records

You can delete a Vision record in Connect for Microsoft Outlook only if you have full rights to that
record (in Configuration » Security » Roles » Record Access tab).

Associations

In Vision, you can associate records with each other. For example, you associate an activity
record with a client record by entering the activity in the Activities grid on the Activities tab of the
Clients form in the Client Info Center. In Connect for Microsoft Outlook, you associate an activity record
with a client by entering an activity in the Activities grid on the Client form.

The same rules and security rights that apply when you associate records with each other in
Vision also apply in Connect for Microsoft Outlook.

When you use a lookup dialog box in Connect for Microsoft Outlook to create an association with
other Vision records, the lookup dialog box will contain only records that have been synchronized
with Connect for Microsoft Outlook. This includes any records that matched your synchronization
filter (complete records) and records that were synchronized because they are associated with a
record that match your filter (incomplete records). See Appendix A on page 94 for more
information about complete and incomplete records.

The following security rules affect the records available in lookup dialog boxes:

=  When you use a lookup dialog box to select an employee or project record to associate with
another record, if you do not have access rights to the Employee or Project Info Center, then
you can see and associate only the employee or project records for which you have view
rights.

=  When you use a lookup dialog box to select a client, contact, vendor, opportunity, or activity
record to associate with another record, you must have both access rights to the Client,
Contact, Vendor, or Opportunity Info Center or the Calendar/Activities application and view
rights to the specific record to be able to make an association. You cannot make associations
with these records if you have view rights only; you must have both access and view rights.

= If your security role has rights to access an application and update records in that application,
in addition to making an association with record from that application, you can edit the
associated record if needed.

Access to Fields within Vision Applications

The Screen Designer in Vision allows you to specify access to specific fields in Vision by security
roles. This access applies in Vision as well as in Connect for Microsoft Outlook.

To access Screen Designer in Vision, open an application, for example the Contacts Info Center.

Click the Screen Designer icon in the bottom right corner of the Contacts form.
The Screen Designer settings that apply when you access Vision data in Outlook are:

= Hidden fields — Select a field on the Designer form. In the Properties panel on the right side
of the form, click the Hidden field, and select the security roles for which you want to hide the
field.

= Locked fields — Select a field on the Designer form. In the Properties panel on the right side
of the form, click the Locked field, and select the security roles for which you want the field
read-only. The field can be viewed but not modified.
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= Required fields — Select a field on the Designer form. In the Properties panel on the right
side of the form, click the Required field, and select the security roles for which you want to
make entry in the field required.

Employees and Projects

Vision employees and projects are synchronized one way only—from Vision to Connect for
Microsoft Outlook.

You cannot create, edit, add, or delete Vision projects or employees in Connect for Microsoft
Outlook. However, you can associate Vision projects and employees with activities, contacts,
clients, opportunities, and vendors in Connect for Microsoft Outlook.

Vision Workflows

Security can sometimes be enforced by Vision workflow. For example, a workflow can make a
field required or read-only and display an error message when a user leaves the field empty or
changes the field. These workflow rules are applied during synchronization.

If you initially have rights to a field, and then a workflow process changes your rights, that change
is enforced during the first synchronization.

Workflows Example

Scenario:

= You have add/modify access to records in the Client Info Center per your Vision security role.
= You add a new client with a relationship of "Existing."

= A workflow is set up for whenever you update a client.

Results:
Vision first checks your security role.

If you are in a non-administrative role, a validate error action in the workflow prevents you from
making any changes to the fields on the General tab for clients with an existing relationship (as
opposed to prospective clients).

You can make changes to these fields for existing clients in Connect for Microsoft Outlook.
However, at synchronization, the client is not updated in Vision. You receive a synchronization
issue with the workflow error message.
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Configuration Settings Passed from Vision to
Connect for Microsoft Outlook

A set of default files on the Vision Web server contain Vision configuration information and the
basic Vision schema that is used to configure Connect for Microsoft Outlook users' mailboxes.
Passing the information in these files to Connect for Microsoft Outlook on users' workstations
allows the Vision data to display in Outlook. This information is passed during the synchronization
process (manual or automatic synchronization).

The following Vision configuration settings are updated to Connect for Microsoft Outlook users'
mailboxes during the initial synchronization when users deploy Connect for Microsoft Outlook for
the first time and any time thereafter when users synchronize after a change is made to the
configuration settings:

=  System-wide labels
= Code table values
= Role security

= Field labels and Required, Locked and Hidden attributes from the Screen Designer

@] Configuration changes made after the initial synchronization

New code table and role security changes are enforced in Connect for Microsoft Outlook after a
user performs the first synchronization after the changes are made.

Changes made in Screen Designer are enforced in Connect for Microsoft Outlook after a user
performs the second synchronization after the changes are made. For example, in Screen
Designer, a system administrator changes a contact field so that an entry in the field is now required
when, previously, you could leave the field blank. After the user synchronizes, the newly required
field is not yet enforced for new records. The new requirement is enforced after the user
synchronizes a second time.

Vision workflow and auto-numbering for clients, opportunities, and vendors are also updated on
Connect for Microsoft Outlook users’ workstations when users synchronize.

The following configuration changes are not passed to Connect for Microsoft Outlook users'
workstations:

= Placement of fields in the Screen Designer

=  User-defined fields
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Back Up Your Outlook Data

Before you download and install Connect for Microsoft Outlook to a user's workstation, we
recommend that you back up your current Microsoft Outlook data using one of the following
methods.

Export Data to a PST File

To back up data in Outlook, export data to a PST file by completing the following steps:

1. Open Outlook, and from the Outlook application-level menu bar, click File » Import and

Export.

2. On the Import and Export Wizard page, select Export to a file from the list and click
Next.

3. Onthe Export to a File page, select Personal Folder File (.pst) from the list, and click
Next.

4. On the Export Personal Folders page, select the appropriate folders that contain personal
data and click Next.

5. Onthe next Export Personal Folders page, click Finish.

Copy Your Outlook Contacts Folder

Create a copy of your Outlook Contacts folder, or copy the contacts in your Outlook Contacts
folder into another contacts folder that does not have the folder named "Contacts." Connect for
Microsoft Outlook synchronizes only the contacts in the contact folder named "Contacts."
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Download and Install Connect for Microsoft
Outlook on a Workstation Using Vision Utilities

Users can download and install Connect for Microsoft Outlook on their workstations, or a system
administrator can use Microsoft Systems Management Server (SMS) to download and install the
software for multiple users at the same time.

This section describes how individual Connect for Microsoft Outlook users can download and
install Connect for Microsoft Outlook on their workstations with Vision Utilities.

/,\ Warning: Connect for Microsoft Outlook cannot be installed on multiple machines using Outlook

== profiles configured to the same mailbox. To install it on a single workstation, you must be logged
into that machine as the user account whose mailbox is being used. That user must be a member
of the local administrator group on that machine during the installation. Local administrator rights
are not needed after the installation.

If you install Connect for Microsoft Outlook on multiple machines using Outlook profiles
configured to the same mailbox, you can damage the mailbox customizations, which may be
time consuming to fix.

/’,\ Before you download and install Connect for Microsoft Outlook on a workstation, the following tasks
—* must be completed:

= You must have installed all the required software, and a Vision system administrator must have
completed the Connect for Microsoft Outlook global configuration, as outlined in the previous
sections of this guide.

=  Microsoft Outlook must be installed on your workstation.
=  An Outlook profile must be created for you.
=  You must have opened Outlook and configured it.

=  Because some antivirus products can interfere with installations, we recommend that you
temporarily disable any antivirus products that are on a workstation. You can enable them
immediately after you complete the Connect for Microsoft Outlook First Run Assistant (FRA)
wizard.

= Your Vision security role must have access rights to the Download Connect for Microsoft
Outlook utility. See the "Access to Download Connect for Microsoft Outlook™ section on page
40 of this guide for more information.

To download and install the Connect for Microsoft Outlook software on your workstation,
complete the following steps:

1. Close Outlook on your workstation.

2. Onthe Applications menu in Vision, click Utilities » Download Connect for Microsoft
Outlook.

3. Onthe Download Connect for Microsoft Outlook form, read the information on the screen,
and click Install and Auto-configure Connect for Microsoft Outlook to start the
software download and complete the installation wizard.
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«» Download Connect for Microsoft Outlook

To wse Connect forMicrosoft Outlook, an Qutlook add-inmust beinstalled. The useof other Outlookadd-ins isnot recommended
with Conmect forMicrosoft Outlook, because they may cause issues such a5 slow perfarmance or application cashes.

Click the balowbuttanta install and suts-configurethe Cannect farMicrasoft Outlaok add-in. Dutlo ok mustbe closed duringthe
installation process.

Instali and Auto-configure Connect for Microsoft Outhook

IF you are unableto install the add-in using the above button, you can use the below button to install and manually configune it.
Install and Manually Configure Connect fior Microsoft Outiook

The followdng information is needed for manuadly configuring Connect for Miorosoft Outiool:
Wb Server: camgawsluna
Virtual Directory: Visionf\isionSasm

Database: VisionDemo#l (camdbistl)

Usemname: ADMIN

#.]  When you click the Install and Auto-configure Connect for Microsoft Outlook button,
the Vision credentials that you used to log on to Vision prefill in the Deltek - Login dialog
box when you complete the Connect for Microsoft Outlook Assistant as described in the
"Deploy and Configure Connect for Microsoft Outlook for the First Time" section on page
57.

When you click the Install and Manually Configure Connect for Microsoft Outlook
button on the Download Connect for Microsoft Outlook form, you must supply the Vision
connection information when you run the Connect for Microsoft Outlook Assistant.

4. On the Welcome to the InstallShield Wizard for Connect for Microsoft Outlook wizard
page, click Next.

Connect for Microsoft Outlook - Insta x|

Welcome to the InstallShield Wizard for
Connect for Microsoft Outlook

The Installshield{R) Wizard will install Connect For Microsoft
Outlook on your computer, To continue, click. Mext,

MYARMING: This program is protected by copyright law and
international treaties.

= Back I et = I Cancel

Installation Guide a7



Deltek gowmore

Download and Install Connect for Microsoft Outlook on a Workstation Using Vision Utilities

5. On the Destination Folder page, select the folder on your workstation in which to install
Connect for Microsoft Outlook.

“.]  The default location is C:\Documents and Settings\<your user name>\Application
Data\Deltek\Connect for Microsoft Outlook\bin\.

Deltek recommends that you keep the default location because the installation is done for
each user’s profile. If you choose to change the installation path, click Change to navigate
to and select a different folder on your workstation.

ji& Connect for Microsoft Outloc

Destination Folder

Click Mext to install ko this Folder, or click Change to install bo a different fc

@ Install Connect For Micrasaft Outlook to:

Ci\Documents and Settings! JuliBertr ambApplication
DakatDeltekiConnect For Microsoft Quthookibin,

Installshield

< Back. I Mext = I Cancel |

6. On the Outlook related settings page, select the Outlook profile to which to install
Connect for Microsoft Outlook. The Outlook profile drop-down list displays all the
profiles available on this workstation.

i.'.:‘-_‘l, Connect for Microsoft Outlo : ll

Outlook related settings

Please select Outlook storage on which Connect: for Microsoft Outlook wiI
installed.

Qutlock profile:
DOE_TE |
Installshield
< Back I Mext = I Cancel
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7. Onthe Ready to Install the Program page, click Install to start the installation.

ii% Connect for Microsoft Dutlook - Inst |
Ready to Install the Program D I k
The wizard is ready ko begin installation, e te ®

Click Insktall ko beqin the installation,

If ywou want to review of change any of your installation settings, click Back. Click Cancel to
exit the wizard.

Imstallshield

< Back I Install I Cancel |

On the Installing Connect for Microsoft Outlook page, you see the status as the
installation proceeds to completion.

ii& Connect for Microsoft Dutlook - In 2| = |0l
Installing Connect for Microsoft Dutlook D It k
The program features vou selected are being installed, e e @

Please wait while the InstallShield YWizard installs Connect For Microsoft
Outlook, This may take several minutes,

Skatus:

Installshield

= Back [t = I Cancel I
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8. On the InstallShield Wizard Completed page, click Finish. The InstallShield wizard
closes.

ii& Connect for Microsoft Dutlook - Insta %]

Installshield Wizard Completed

The Installshield Wizard has successfully installed Connect For
Microsoft Outlook, Click Finish to exit the wizard,

[~ Showe the Windows Inskaller log

< Back I Finish I Cance| |

Continue with the "Avoid Duplicate Contact Records" instructions on page 56 of this guide.
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Use Command Line Parameters To Deploy
Connect for Microsoft Outlook on Multiple
Workstations

A system administrator can deploy Connect for Microsoft Outlook on multiple workstations and for
multiple users via several options such as Microsoft Systems Management Server (SMS), Group
Policy, or batch files. This section lists the parameters and provides examples of how to use
command line parameters to deploy Connect for Microsoft Outlook silently with different
configuration settings.

,,f”g\ Before you download and install Connect for Microsoft Outlook on workstations using SMS, the
—— following tasks must be completed:

=  You must have installed all the required software and completed the Connect for Microsoft
Outlook global configuration as outlined in the previous sections of this guide.

=  Microsoft Outlook must be installed on users' workstations.
=  An Outlook profile must be created for each user.
=  You must have opened Outlook and configured it.

=  Because some antivirus products can interfere with installations, we recommend that you
temporarily disable any antivirus products that are on a workstation. You can enable them
immediately after you complete the Connect for Microsoft Outlook First Run Assistant (FRA)
wizard.

Connect for Microsoft Outlook is a Microsoft Installer MSI package file that supports most of the
command line parameters for deploying MSI for multiple users.

¥% You can use the command line to set optional parameters that impact installation. You run the
installer program from a Windows DOS command line on a Connect for Microsoft Outlook user's
workstation or from a command line on the SMS server.

Connect for Microsoft Outlook supports most parameters that can be set in the msiexec command
line. For a list of the MSI optional parameters, launch a command prompt and enter:

msiexec.exe /[?

For detailed information, see the documentation about Msiexec command-line options at the
following Microsoft TechNet Website:

http://msdn.microsoft.com/en-us/library/aa367988%28VS.85%29.aspx

Set Optional Parameters During Installation

To use the command line to set optional parameters during installation, complete the
following steps:

1. Open a DOS command line.

2. Navigate to the directory that contains the Connect for Microsoft Outlook.msi file, such
as C:\WINDOWS\system32.
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3. Enter the msiexec command. Use the following syntax:

msiexec.exe /i Connect for Microsoft Outlook.msi <optional_parameter_ 1>
<optional_parameter_n>

Where optional_parameter is a parameter that you can enter that is executed when the
installer runs.

®.] = You must specify each optional parameter in the same command line after the name
of the Connect for Microsoft Outlook.msi file.

=  You must enter a space without a slash to separate each optional parameter.

=  You can arrange optional parameters in any order.

4. Click Enter.
The Welcome page of the Connect for Microsoft Outlook Setup wizard displays.

You can use the optional QR parameter to automatically execute the windows that
normally require user action. When you use the QR parameter, the installer does not
display dialog boxes that require user action.

Parameters that Are Available for Silent Installation
The following special values are supported for the OL_PROFILE parameter:

=  $DEFAULT — When you specify this value, the default profile and default storage in this
profile is used. The default profile is the profile specified in Control Panel » Mail »
Profiles » Always use this profile. Default storage is the mail delivery location specified
for the profile in OL_PROFILE.

= $PREFERRED — When you specify this value, the profile is detected using the same
algorithm as described for the $DEFAULT value. However, if a default profile is not found
or is invalid, the installation chooses any other suitable profile. If no value is specified for
the OL_PROFILE parameter, $PREFERRED value is used.

If the installation parameters values contain spaces, the parameters must be enclosed within
guotation marks.

The following Deltek parameters that correspond to the initial Connect For Microsoft Outlook login
and configuration form can be passed to the installer to preconfigure the application. Parameter
values must be enclosed in quotation marks (* ).

Deltek Parameters Value Description

OL_PROFILE= Optional.

This is the Microsoft Outlook mail profile name that is found in
the Windows Control Panel » Mail » Show Profiles section.
If you are unsure what the mail profile name will be, do not
enter this value. After installation, the default mail profile will
be used when Connect for Microsoft Outlook is launched.

Example: OL_PROFILE="Outlook”
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Deltek Parameters

DELTEK_SERVER_URL=

| Value Description

URL (with optional port number) to the Vision Web service
ASMX page on the Vision Web server. The URL always ends
in visionws.asmx.

Example:

DELTEK_SERVER_URL=http://webserver:80/vision/visionws.
asmx

DELTEK_DATABASE=

This is the description field of the Vision database that you are
connecting (as displayed in Weblink or from the login drop-
down list).

Example:
DELTEK_DATABASE="VisionDemo61 (DBSERVER1)"

DELTEK_USERNAME=

This is the Vision Login/Username. Use this parameter if you
are not using Integrated Authentication to log in to Windows.
This cannot be used with the DELTEK_NT_AUTH parameter.

Example: DELTEK_USERNAME="ADMIN"

DELTEK_NT_AUTH=

Enter this parameter if you are using Windows Integrated
Authentication to log in to Vision.

Example: DELTEK_NT_AUTH="1"

SEINES | Value

Example 1

The Outlook profile named
“Outlook” is specified, and
Deltek Security is used.
Optional Windows Installer /gr
switches are used to display
installation status with no
user interaction required.

msiexec /i
"\\fileserver1\Deltek\ConnectForMicrosoftOutlook.msi" /qr
OL_PROFILE="Outlook"
DELTEK_SERVER_URL="http://webserver/Vision/VisionWS.as
mx" DELTEK_DATABASE="VisionDemo (DBSERVER1)"
DELTEK_USERNAME="ADMIN"

Example 2

No Outlook profiles are
specified and Windows
Authentication is used.
Optional Windows Installer /gr
switches are used to display
the installation status with no
user interaction required.

msiexec /i
"\\fileserver1\Deltek\ConnectForMicrosoftOutlook.msi" /qr
DELTEK_SERVER_URL="http://webserver:80/Vision/VisionWS
.asmx" DELTEK_DATABASE="VisionDemo61 (DBSERVER1)"
DELTEK_NT_AUTH="1"

Example 3

Uninstalling with a command
line parameter

msiexec /uninstall
"\\fileserver1\Deltek\ConnectForMicrosoftOutlook.msi" /qr

Installation Guide

53



http://webserver/vision/visionws.asmx
http://webserver/vision/visionws.asmx

Deltek gowmore

Download and Install Connect for Microsoft Outlook on Multiple Workstations Using Microsoft SMS or Group Policy

Download and Install Connect for Microsoft
Outlook on Multiple Workstations Using Microsoft
SMS or Group Policy

A system administrator can use Microsoft Systems Management Server (SMS), Group Policy, or
batch files to deploy Connect for Microsoft Outlook for multiple users. This section contains a
summary of the installation steps using Microsoft SMS 2003 Server and Group Policy.

A

For detailed information, see the following Microsoft article:

http://technet.microsoft.com/en-us/updatemanagement/bb245825.aspx.

Before you download and install Connect for Microsoft Outlook on workstations using SMS, the
following tasks must be completed:

= You must have installed all the required software and completed the Connect for Microsoft
Outlook global configuration outlined in the previous sections of this guide.

= Microsoft Outlook must be installed on users' workstations.
=  An Outlook profile must be created for each user.
=  You must have opened Outlook and configured it.

=  Because some antivirus products can interfere with installations, we recommend that you
temporarily disable any antivirus products that are on a workstation. You can enable them
immediately after you complete the Connect for Microsoft Outlook First Run Assistant (FRA)
wizard.

Summary Of Steps

The following is a summary of the installation steps when you use SMS to install Connect for
Microsoft Outlook on multiple workstations:

1.

o > w0

o

Create a collection that contains the users, computers, workgroups, or domains to which
you want to distribute the Connect for Microsoft Outlook software.

Create a distribution package.
Specify a collection to which the installation belongs.
Create an advertisement of this distribution package for the collection.

Notify Connect for Microsoft Outlook users that Connect for Microsoft Outlook is ready for
them to configure on their workstations.

Create a membership rule.
Use the command line to set optional parameters during installation.

See the "Use Command Line Parameters To Deploy Connect for Microsoft Outlook on
Multiple Workstations" section on page 51.
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Avoid Duplicate Contact Records

*.J

If you are migrating from Vision Synchronization Server or other software to Connect for Microsoft
Outlook, the instructions in this section do not apply. Instead, see the "Synchronization Server and
Other Migrations: Prevent Duplicate Contacts" section on page 17 for steps to take to prevent
duplicate contacts.

To avoid duplicate contact records from being created in Connect for Microsoft Outlook after you
synchronize for the first time, Deltek recommends that each Connect for Microsoft Outlook user
complete the following:

1. You should have a backup copy of your Outlook data per the instructions in the "Back Up

Your Outlook Data" section on page 45 before you install Connect for Microsoft Outlook
on a workstation.

If you did not make a backup before you downloaded and installed Connect for Microsoft
Outlook, complete the following: When you open Outlook for the first time, the Connect
for Microsoft Outlook Assistant displays in Outlook. Cancel the assistant by clicking
anywhere outside the Connect for Microsoft Outlook Assistant page. Then complete the
backup instructions on page 45. To restart the Connect for Microsoft Outlook Assistant,
close and reopen Outlook.

In the next section "Deploy and Configure Connect for Microsoft Outlook for the First
Time" that starts on page 57, be sure to select the most appropriate unshared status for
your situation in the Confirm Outlook Contact Conversion dialog box.

On the Confirm Outlook Contact Conversion dialog box, you have the option to convert
your contacts as unshared contacts.

= Deltek recommends that you select Yes to convert existing Outlook contacts to
unshared contacts if most of your Outlook contacts should be added to Vision.

=  If most of your Outlook contacts are private contacts, then you should not convert
existing Outlook contacts to unshared contacts. This ensures that the Outlook
Company field remains for private contacts. It also ensures that Vision business logic
is not enforced for your private contacts (for example, required fields).

@, Native contacts are contacts that you create in standard Outlook. Native Outlook contacts
must be converted to unshared contacts before you can share them with Vision. You can
convert native contacts to unshared contacts when you deploy and configure Connect for
Microsoft Outlook for the first time. Thereafter, you can convert native contacts in Connect
for Microsoft Outlook using the Convert to Unshared command on the Actions menu.
After native contacts become unshared, use the Shared with Deltek bar on a contact-by-
contact basis on the Contact form to share native Outlook contacts with Vision.

3. After you complete the "Deploy and Configure Connect for Microsoft Outlook for the First

Time" instructions in the next section of this guide, follow the instructions in the "Check
and Resolve Duplicate Contact Records" section on page 72.
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Deploy and Configure Connect for Microsoft
Outlook for the First Time

When you start Outlook the first time after you install Connect for Microsoft Outlook, the Connect
for Microsoft Outlook Assistant starts automatically. It guides you through the steps to configure
Connect for Microsoft Outlook.

After you enter configuration settings with the Connect for Microsoft Outlook Assistant and the
initial synchronization finishes, you can start to use the Connect for Microsoft Outlook software.

/j Deltek recommends that you stagger the initial Connect for Microsoft Outlook implementation so

==* that a significant number of users are not performing the initial synchronization all at the same time.
This will help prevent overloading your system. Users perform the initial synchronization when they
complete the Connect for Microsoft Outlook Assistant, as described in this section of the guide.

For more information about synchronization schedules and automatic synchronization after the
initial synchronization, see "Appendix C: Synchronization Schedules" on page 113.

Summary of Configuration Information

The following is a summary of the configuration information that you enter using the Connect for
Microsoft Outlook Assistant:

= Connection settings — You set up an Internet connection to your Vision database. If the
connection cannot be established automatically, you enter it manually.

= Vision credentials — Enter either your Vision user name and password or select Windows
authentication. These credentials enable Connect for Microsoft Outlook to access and
synchronize the Vision data. With these saved credentials, you do not have to log in to Vision
each time that you start Outlook.

= Obtain package —Vision information, based on your Vision employee record and security
role, is downloaded automatically to Connect for Microsoft Outlook. After the package
information is downloaded, the Vision Activities, Clients, Opportunities, and Vendors folders
display in the Connect for Microsoft Outlook Folder List view of the Navigation pane.

=  Filter settings — You set up data filters to limit the Vision records that are synchronized to
Connect for Microsoft Outlook. For optimal synchronization performance, Deltek recommends
that you apply filters to allow no more than 5,000 records to be synchronized.

= Synchronization schedule — You select the time interval for automatic synchronization
between Vision and Connect for Microsoft Outlook to occur.

= Advanced settings — You specify whether or not new appointments, contacts, and tasks
that you create in Connect for Microsoft Outlook will be shared and available in Vision by
default. You can change the sharing/unshared status when you create a new item, or later on
an item-by-item basis as you work in Connect for Microsoft Outlook.

= Convert items — You choose whether or not you want Vision-specific fields added to
existing contacts in Connect for Microsoft Outlook.

= First synchronization — You perform the first synchronization. Vision data is downloaded to
Connect for Microsoft Outlook based on your filter settings and the business rules of
synchronization.
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Steps to Deploy and Configure

To enter Connect for Microsoft Outlook configuration settings with the Connect for
Microsoft Outlook Assistant, complete the following steps:

1.

2.

After you install Connect for Microsoft Outlook, open Outlook.

If you have more than one Outlook profile, you must enter the profile to which you
installed Connect for Microsoft Outlook when prompted.

The Connect for Microsoft Outlook Assistant Welcome page displays in Outlook.

Connect for Microsoft Outlook Assistant

¥ Welcome

Connection Settings /
Login Credentials
Obtain Package \
P i N

Welcome to the Connect for Microsoft Qutlook First Run Assistant! It
will guide you through the application settings.

Clicking outside the First Run Assistant will close the window. You
can open it again by selecting an option from the application icon in
the taskbar.

Click the First Run Assistant o proceed to the next step.

“.]  You can cancel the Connect for Microsoft Outlook Assistant at any time by clicking outside
the Connect for Microsoft Outlook Assistant page. If you cancel and do not complete all the
configuration settings, the Connect for Microsoft Outlook Assistant continues to display
when you start Outlook until you complete all the settings.

Click anywhere on the Connect for Microsoft Outlook Welcome page to start the Connect
for Microsoft Outlook Assistant.

The process begins automatically and proceeds in the order listed on the Welcome page,
regardless of which step you click.

Connection settings are checked to find an Internet connection to access your Vision
database. If the connection cannot be made automatically, the Connections tab of the
Options dialog box opens, and you can manually enter the connection settings.

Your Vision system administrator can provide you with Internet connection information if
the connection is not made automatically.

@ Default settings are appropriate in most cases. However, if your system administrator
configured a proxy server or requires additional configuration settings to connect to the
Internet, you must get that information from the system administrator. If necessary, you
can find answers for the proxy server settings on the Local Area Network (LAN) Settings
dialog box in Microsoft Internet Explorer in Tools » Internet Options » Connections tab
» LAN Settings button.
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On the Connection tab of the Connect for Microsoft Outlook - Options dialog box, select
one of the following:

= Direct connection to the Internet (no proxy-server) — Select this option if you do
not need to enter any proxy server or additional configuration settings to connect to
the Internet.

= Use Internet Explorer settings for proxy server — Select this option if your system
administrator has preconfigured your Microsoft Internet Explorer Connections
settings with a proxy server.

= Manual proxy-server configuration — Contact your system administrator for the
proxy-server configuration information if your firm uses a proxy server for Internet
access.

= Server — Enter your Vision database server name.
= User Name — Enter your Windows user hame.

= Password — Enter your Windows password.

onnect for Microsoft Dutlook - Options x|

E [ Procy Configuration

Connection ™ Direct connection to the Internet (no proxy-server]

%" Use Inkernet Explorer settings For proxy-server

" Manual proxy-server configuration

Server: |

Lzer Mame: |

Password: |

ok | Cancel aply

4. When you finish entering connection information, click OK to save the settings and
continue.

= If you clicked the Install and Auto-configure Connect for Microsoft Outlook
button on the Download Connect for Microsoft Outlook form in Vision Utilities »
Download Connect for Microsoft Outlook, the Vision credentials that you used to
log on to Vision are used to prefill the information on the Deltek - Login dialog box.

= If you clicked the Install and Manually Configure Connect for Microsoft Outlook
button on the Download Connect for Microsoft Outlook form, you must supply the
Vision connection information in the Deltek — Login dialog box.
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% Deltek - Login s EI

Web Server Fort

Deltek Location [http:jf x| |visionwebserver J
Virtual Directory: | Vision/Visioniy'5, asm

Lagin
Database [VisionDema61 (camdbtst1) =
[ Use Windows Authentication

Username: { ADMIN
Password: |

5. Enter the following information on the Deltek Login dialog box:
Server section:
= Deltek Location — This section is the path to your Vision Web server.

= Web Server — This is your Vision database server name. It should contain only the
server name IP address (not the remainder of the URL). You enter the URL in the
virtual directory section.

= Port — Leave this blank unless you are using a port other than default port 80.

= Virtual Directory — This is a combination of your Vision virtual directory and the
visionws.asmx file. The visionws.asmx is always required. In the screen shot
example, the virtual directory is named Vision.

Login section:

In this section, you select whether to use Windows authentication or your Vision
username and password for Connect for Microsoft Outlook to access Vision data.

= Database — After you enter the server information and connections are made, a list
of available Vision databases display in the drop-down list. Select the appropriate
Vision database.

= Use Windows Authentication — Select this check box to use your Windows user
name and password.

= User Name — If you do not select Windows authentication, enter your Vision
username.

= Password — If you do not select Windows authentication, enter your Vision
password.

6. When you finish entering Vision login information, click Save.

The configuration settings that are based on your Vision employee information are
automatically downloaded from Vision and applied to Connect for Microsoft Outlook
during the "Obtain Package" process. This can take a few minutes. A box displays the
progress of this download.
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Connect For Microsoft Qutlook: Applving configur ation: CRGEClientRelationship

]

When this process finishes, the following Connect for Microsoft Outlook Assistant

Welcome page displays.

Connect for Microsoft Outlook Assistant

» Welcome

Welcome to the Connect for Microsoft Outlook First Run Assistant! It will
guide you through the application settings.

Clicking outside the First Run Assistant will close the window. You can
open it again by saelecting an option from the application icon in the
taskbar.

Click the First Run Assistant to proceed to the next step.

7. Click anywhere on the Connect for Microsoft Outlook Assistant Welcome page to open

the Filter Records screen of the Synchronization Control Panel dialog box.

On the Filter Records screen, you enter filter conditions to determine the Vision records

that will synchronize with Connect for Microsoft Outlook.

",'—» Synchronization Control Panel

Filter Records

Please, specify the criteria vou'd like to use For determining which Delkek items have ta be synchronized with
Connect For Mickasoft Qutlaok, The Following Filkers are applied to selected categories and subcateqgaries,

Fw Activities

~ Drecord(s)

Check Issues  Resolve Conflicts Resalve Confirm
Duplicates Synchronization

#-4 Client
7 18 record(s)

Contact
" Srecord(s)

# Employee
e 33 record(s)

"4 Opportunity
18 record(s)

i Project
D “D record(s)
O i Vendor

SE2 0 record(s)

Remove local records not matching Filkering criteria

74 record(s) accessible Presets SEYE Close
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Select a
check box for
the type of
Vision record
to
synchronize.
Then click
the check
box name.

“&J [}

Set the filters to select only the records that you normally work with. Filtering records

limits the amount of records that synchronize from Vision to Connect for Microsoft
Outlook. This reduces the time it takes to synchronize.

allow no more than 5,000 records to be synchronized.

For optimal synchronization performance, Deltek recommends that you apply filters to

In the pane on the left side of the Filter Records screen, select the check box for the type
of Vision record that you want to synchronize with Connect for Microsoft Outlook. Then

click the check box name to display Match criteria: All and Any and the default filter
condition in the filter criteria pane.

In the example below, the Client check box is selected and the check box name is

highlighted in gray.

¥ Synchronization Control Panel

D

Filter Recards

A

(317)

Specify criteria For determining which Deltek recards will be synchronized with your Outlaok. The Following filkers are applied ta

Estimated Record Counts

F'I?A Activities

1 record(s)

S -1 Clients /v

7 19 record(s)

¢ Contacts
5 26 record(s)

# Employees
@ 46 record(s)

<" Opportunities
¥ 18 record(s)

| Projects
D $ 0 recardis)

O i Vendors

ZEZ 0 pecord(s)

Remave local recards nat matching Filkering criteria

Check Issues Resolve Conflicks

Canfirm
Synchronization

Resolve
Duplicates

the selected cateqories and subcategories
Clients ('LinkedToMe'="trug")

Match criteria: & al O any

LinkedToMe = trus |

Add a condition icon

Filter Criteria Pane

4

Add group of conditions icon

Estimated 110 recordis) accessible

Exclusions. .. | Presets | Save

Close:

In the filter criteria pane, you see the default filter — LinkedToMe = true.

See "Appendix B: Synchronization Filters" on page 96 for more information about the
default filters for Vision record types.

You can delete a default filter (or any filter) by clicking the trash can IEI icon to the right
of the filter in the filter criteria pane. To reset the default filters, click the Presets button at
the bottom of the Filter Records screen, and then select Default Filters. This resets the
default filters for all records types.

@ Check box names (Activities, Customer, Contact, and so on) on the Filter Records
screen are bolded when filter conditions have been entered for them.
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9. At the bottom of the filter criteria pane, click the Add a condition icon to open the
Connect for Microsoft Outlook Filter — Edit Criterion dialog box. Create a filter by selecting
a field, condition, and value, and click OK.

& Connect for Microsoft Dutlook Filter - Edit Eril:é,f__:_: ) x|

Figld: Condition: Yalue:

| = =

(a4 Cancel I

Filter condition example: To create a condition that retrieves all clients with an active
status, select Status in the Field field, = in the Condition field, and Active in the Value
field.

= The fields that display in the Field drop-down list are determined by the record
(Activities, Client, Contact, and so on) that you choose on the Filter Record screen.

= The Condition drop-down list contains options, such as = (equal to), <> (except), Is

Null (empty), and so on, that are appropriate for the type of field that you selected in
the Field field.

' Connect for Microsoft Dutlook Filter - Edit Criterion

Field: Condition: Yalue:
IStatus j |= - | I j
Ik Cancel |
Is mull
Is Mok rull

= Value — The Value field is either blank and you enter text, or you select an item from
a drop-down list, based on what you entered in the Field field.

® Connect for Microsoft Dutlook Filter - Edit Criterion

Field: Condition: Yalue:

IStaI:us j |= j j
Ackive
Darrnank
Inactive -
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After you click OK on the Connect for Microsoft Outlook Filter — Edit Criterion dialog box

to save a condition, the complete condition statement displays at the top of the filter
criteria pane.

¥ Synchronization Control Panel

[

Filter Recards | Check Issues FResolve Conflicks Resolve Confirm i
(317) Duplicates Synchironization The CompIEte filter

Specify criteria for determining which Deltek records will be synchronized with your Gutlook, The Following filkers are 3 Statement 1S .
bk a O o e s com prlsed Of a” f||ter
Estimated Record Counts @kﬁdmw:“tme" AD 'Stat”5'="""cti*‘eD <«— conditions that you
Fige Activities entered for the
" L record(s) Match criteria: @Al O Any selected record type.

gy Clients LinkedTaMe = true 1§

16 record(s) | :
Status = Active ||
' Contacts

Filter conditions
« 26 record(s]

¥ Employees
@ 46 record(s)

" Opportunities
hu""" 18 record(s)

| Projects
D B0 recordis)

i Wendors 5 ¥
D SEL 0 pecord(s)

Remove local records nok matching Filkering crikeria

Estimated 107 recordis) accessible Exclusions, .. | Presets | Save Close

10. To enter additional filter conditions, repeat step 9. You can add:
=  An unlimited number of single conditions.
=  Conditions for the records that are associated with top-level records.

= A group of conditions (nested conditions) using the Add group of conditions
icon.

See "Appendix B: Synchronization Filters" on page 96 for more information about creating
filter conditions. This includes instructions on how to create conditions for associated
records and group conditions.

11. In the filter criteria pane, select the Match criteria setting as follows:

= If you enter more than one filter, select All (AND-based) to synchronize records that
match all of the conditions that you enter for a record.

= If you enter more than one filter, select Any (OR-based) to synchronize records that

match any one of the filter conditions; records do not have to meet all the filter
conditions.

To create filters that mix AND and OR conditions, you must use a group (nested)
condition.

See "Appendix B: Synchronization Filters" on page 96 for more information on group
conditions.
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® Synchronization Control Panel |

Displays the
number of
complete
records to
synchronize

Filtet Records | Check Issues Fesolve Conflicks Resolve Confirmn
{41) Duplicates Synchronization

Please, specify the criteria vou'd like to use for determining which Deltek items have to be synchronized with
Connect For Microsoft Outlook, The Fallowing Filkers are applied to selected categaries and subcategories,

Client ({'LinkedToMe'=true AND "Status'="active"))
* Activities

O

S 0 record(s)

2 -5 Client :
- & :
:‘& 15 record(;

i w

Match criteria; (Al O any

< Match criteria: All or A
LinkedToMe = true

Skatus = Active

Contact
ﬁ 5 record(s)

# Employee
D i g record(z) ‘

i Opportunity
D u’ 0 record(s)

D Project
0 record(z)

= endor -

B2 ) record(z) ——

N
~N

Multiple Single Filter
Conditions

=0

Remaove local records not matching filkering criteria

20 record(s) accessible Presets | SaVE | Close |

= Records that match your filter conditions are synchronized and brought into Connect
for Microsoft Outlook as "complete” records. This means all their information appears
on the record form in Connect for Microsoft Outlook.

= Records that do not match your filter criteria are synchronized and brought into
Connect for Microsoft Outlook if they are associated with records that match your
filter conditions. However, these records are brought in to Connect for Microsoft
Outlook as "incomplete" records. This means that the records are read-only in
Connect for Microsoft Outlook, regardless of your access rights. Associations to the
associated records are not brought into Connect for Microsoft Outlook at all. This
prevents all records from coming into Connect for Microsoft Outlook through
associations.

A

See Appendix A on page 94 for more information and an example of complete and
incomplete records.

) If you clear the Remove local records not matching filtering criteria check box on the
Synchronization Control Panel dialog box, Vision records that synchronized previously, but
do not match your current filter requirements, remain in Connect for Microsoft Outlook. Be
aware that when you make any changes to these records in Vision, the changes are not
updated to Connect for Microsoft Outlook when you synchronize.

12. When you finish creating filters, click Save and then click Close.

#.] To edit a single filter condition, double-click it in the filter criteria pane to open the Connect
for Microsoft Outlook Filter— Edit Criterion dialog box.
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13. On the Synchronization tab of the Options dialog box that displays automatically,
complete the following settings:

*% Connect for Microsoft Dutlook - Options i x|

J Q —Aukarun
IT‘ General ¥ Schedule an automatic synchronization inkerwval:

1
Synchronization Frequent J Rare

=32 Cnce an Hour
| ﬂ Feedback,

Mext synchronization will occur Wednesday, February 03, 2010 ak 11:

% Connection ¥ show progress during automatic synchronization

Show Cantral Panel, ..

K Cancel apply

= Schedule an automatic synchronization interval — Select this check box to have
synchronization occur automatically at regular intervals.

= Frequency slider bar — If you selected the Schedule an automatic
synchronization interval check box, use this slider to select the automatic
synchronization frequency.

The options are:

= Once an Hour (default)
= Twice a Day

= Once aDay

= Once aWeek

The time of the next synchronization displays below the Frequency slider bar.

[I.ll See "Appendix C: Synchronization Schedules" on page 113 for more information
about automatic synchronization scheduling.

= Show progress during automatic synchronization — Select this check box if you
want the following synchronization progress dialog box to display during automatic
synchronization.
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<" Checking amount
Querying records
Analvzing relations
Synchronizing records

Skop |

The Stop button on the synchronization dialog box stops the synchronization. When
you click this button, the synchronization stops after it finishes the current operation
in process (it does not stop immediately).

When you click the button in the upper right corner of the screen, it minimizes the
dialog box, and it does not stop the synchronization process.

“.] Regardless of the synchronization settings that you select on the Connect for
Microsoft Outlook Options dialog box, you can synchronize at any time. Select one of
the following actions:

= |eft-click the Connect for Microsoft Outlook icon in the taskbar that
displays by default at the bottom of the Windows desktop.

= Right-click the Connect for Microsoft Outlook icon, and then select
Synchronize Now from the menu. This allows you to display the Filtering Control
Panel and the Configuration Options.

= Show Control Panel — Click this button to open the Synchronization Control Panel
dialog box. On this dialog box, you can select filter options for synchronization. The
screen shot in step 7 displays the Synchronization Control Panel dialog box.

14. When you finish entering settings on the Synchronization tab of the Options dialog box,
click OK to save your settings.

#J

To change synchronization settings at any time after you use the Connect for
Microsoft Outlook Assistant during the initial installation, complete the following
steps:

1. On the Windows taskbar, right-click the Connect for Microsoft Outlook icon
and click Options.

2. On the Connect for Microsoft Outlook — Options dialog box, click the
Synchronization tab.
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15. On the Advanced tab of the Connect for Microsoft Outlook Options dialog box that
displays automatically, select the default setting for sharing new contacts, calendar
items, and tasks that you create in Connect for Microsoft Outlook with Vision.

& Connect for Microsoft Outlook - Options x|

i‘ﬂ lg | Cutlook, Inkegration
Zenera
e

Automatically Share Mew

L
@ Synchraonization [ Contacts, Calendar Events and Tasks

¥

¥ Feedback

Connection

Advanced

% L4

1 Jabout

(] 4 Cancel Apply

=  Select the Automatically Share New Contacts, Calendar Events and Tasks check
box if you want to share new records automatically with Vision by default.

Shared contacts, calendar items, and tasks:

= Contain Vision-specific data fields not found in Outlook (for example the
Client/Vendor field on the Connect for Microsoft Outlook Contact form).

= Synchronize with Vision and display in Vision and Connect for Microsoft Outlook.

= Clear the Automatically Share New Contacts, Calendar Events and Tasks check
box if you do not want to share new records with Vision by default.

The contacts, calendar items, and tasks that you do not share with Vision are
considered to be native Outlook.

Native Outlook items:

= Display in Connect for Microsoft Outlook only and do not synchronize with Vision.
= Do not contain Vision-specific data fields.
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“&J =  After you complete the Connect for Microsoft Outlook Assistant, you can change the
default setting for sharing new contacts, calendar events, and tasks at any time by

right-clicking the Connect for Microsoft icon on the Windows taskbar and
selecting the Options menu. Then select the Advanced tab on the Connect for
Microsoft Outlook — Options dialog box.

= You can override the prefilled default setting when you create individual records in
Connect for Microsoft Outlook.

= You can switch records from shared to unshared and vice versa at any time on a
record-by-record basis by clicking the Shared with Deltek bar on the record's form in
Connect for Microsoft Outlook.

16. After you make your selection, click OK. The Advanced Options dialog box closes and
the Convert Items process begins automatically.

The following Confirm Outlook Contact Conversion dialog box displays, asking whether
or not you want to convert existing Outlook contacts to unshared business contacts.

Confirm Dutlook Contack Conversion x|

?/ Should the Connect For Microsoft Outlook installation process convert existing Outlook contacts to unshared business
- conkactsy

= Click Yes if you want existing Outlook contacts that were originally created in native
(standard) Outlook to be converted to unshared contacts in Connect for Microsoft
Outlook.

If most of your Outlook contacts should be added to Vision, Deltek recommends that
you click Yes.

/R‘ Vision Synchronization Server Migrations

If you are migrating from Vision Synchronization Server to Connect for Microsoft
Outlook, you must click Yes to avoid duplicate contacts in Outlook. When you choose
Yes, Connect for Microsoft Outlook looks in Outlook for any contact records that have
a category of DLTKSYNC. If they do, it automatically converts them to the shared
status.

Any contact that has a DLTKSYNC category in Outlook that does not exist in Vision
will be deleted from Outlook.

See the “Synchronization Server and Other Migrations: Prevent Duplicate Contacts”
section on page 29 for more information about Synchronization Server migrations.

Unshared Contacts in Connect for Microsoft Outlook

Before you can share native (standard) Outlook contacts with Vision, you must
convert them from native to unshared. Then you can change unshared contacts to
shared contacts. Unshared contacts:

= Are not synchronized with Vision. They display in Connect for Microsoft Outlook
only.

= Contain Vision-specific data fields that are not available in Outlook (for example
the Client/Vendor field on the Connect for Microsoft Outlook Contact form).
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= Can be shared with Vision on a contact-by-contact basis at any time by clicking
the Shared with Deltek bar for the contact on the Contact form in Connect for
Microsoft Outlook.

= Include the Vision business logic. For example, fields that are required in Vision
are required for unshared contacts.

= Click No on the Confirm Outlook Contact Conversion dialog box if you want existing
native Outlook contacts to remain as native Outlook contacts.

If most of your Outlook contacts are private contacts, we recommend that you click
No. This ensures that the Outlook Company field remains for private contacts.
Native Outlook contacts:

= Display in Connect for Microsoft Outlook only and do not synchronize with Vision.
= Do not contain Vision-specific data fields.
= Do not contain Vision business logic.

If you click No on the Confirm Outlook Contact Conversion dialog box, you can use
the Convert to Deltek Form command on the Actions menu in Connect for Microsoft
Outlook to convert native contacts to unshared contacts on a contact-by-contact
basis. Then, you can click the Shared with Deltek bar on the Contact form to share
contacts with Vision. See the Sharing Records topic in the Connect for Microsoft
Outlook help for specific instructions.

@] Calendar Items and Tasks

The converting process converts all existing calendar items and tasks to unshared if
they do not match the filter criteria. If they match the filter criteria, they are
automatically shared with Deltek. Then, you can share any calendar item or task on
an item-by-item basis by clicking the Shared with Deltek bar on the record form.

When the Convert Items process finishes, the Connect for Microsoft Outlook
Synchronization dialog box displays automatically. Synchronization takes place to upload
Vision data into Connect for Microsoft Outlook for the first time.

& Connect for Microsoft Outlo -_: x|

+ Connecking

£' Checking anmount
Querying records
Analyzing relations
Synchronizing records

Stop |
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#J

Vision data is downloaded into Connect for Microsoft Outlook based on the following:

The filter criteria that you entered in the Connect for Microsoft Outlook Assistant.
Your Vision security access.

Whether or not a Vision record is associated with another Vision record that is
downloaded to Connect for Microsoft Outlook.

Records that match your filter criteria are synchronized and brought into Connect for
Microsoft Outlook as "complete" records. You see all their information displayed on
the record form in Connect for Microsoft Outlook.

Records that do not match your filter criteria, but which are synchronized because
they are associated to records that match your criteria, are also brought into
Connect for Microsoft Outlook. However, these records are brought in as
"incomplete” records. This means they are read-only in Connect for Microsoft
Outlook, regardless of your access rights. Associations to the associated records
are not brought into Connect for Microsoft Outlook at all. This prevents all records
from coming into Connect for Microsoft Outlook through associations.

See Appendix A on page 94 for more information and an example of complete and
incomplete records.

The Stop button on the Connect for Microsoft Outlook Synchronization dialog box stops
the synchronization. When you click this button, the synchronization stops after if finishes
the current operation in process (it does not stop immediately).

The button at the top right of the dialog box minimizes the dialog box, and does not
stop the synchronization process.

When the Synchronization dialog box closes, you can use Connect for Microsoft Outlook.

#.  You can view or modify the Connect for Microsoft Outlook configuration settings after the
initial set up by completing the following steps:

1.

Right-click the Connect for Microsoft Outlook icon on the taskbar that displays
by default at the bottom of your Windows desktop.

Select one of the following:

=  Show Control Panel — Opens the Synchronization Control Panel where you
select Filter Records criteria.

=  Options — Opens the Options dialog box where you access the other Connect
for Microsoft Outlook configuration settings.
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Check and Resolve Duplicate Contact Records

With the following instructions, you can check and resolve any duplicate contact records that
were created after you synchronized Connect for Microsoft Outlook for the first time.

Duplicates are not detected during the first synchronization because there are no shared records
in your Outlook. After the first synchronization, duplicate records will exist in your Outlook if you
had any Vision contacts already in your Outlook and those contacts matched your
synchronization filter. In this scenario, one contact is in a unshared or native state and the same
contact in a shared state. If you decide to share the pre-existing contact, then a duplicate will be
caught during your next synchronization.

@ If you are migrating from Vision Synchronization Server to Connect for Microsoft Outlook, you can
skip these instructions. Instead, see the "Vision Synchronization Server Migrations" section on page
17 for information about preventing duplicate contacts.

To check and resolve duplicate contact records, complete the following steps:

1. After you synchronize Connect for Microsoft Outlook for the first time (as described in the
previous section), sort the list of contacts in Connect for Microsoft Outlook by name.

2. Scan the contact list for any potential duplicates. If a Vision contact existed in Outlook
before you installed Connect for Microsoft Outlook and that contact matched your
synchronization filter, then there will be two occurrences of the contact in Connect for
Microsoft Outlook. One contact is in a shared state. The other is in a native or unshared
state depending on the state you select for the contact conversion when you deployed
and configured Connect for Microsoft Outlook for the first time.

You can tell whether a contact is native, unshared, or shared by the icon located beside
the contact name in the contact list:

= 84 _ Native Outlook contact
. & _ Unshared contact

. & _ Shared contact
3. When you find a duplicate contact, open the two records and compare them.

On the Contact form, update the shared contact with any additional information from your
native or unshared contact.

4. After ensuring that the shared contact has all the information from your native or
unshared contact, delete the native or unshared contact from Connect for Microsoft
Outlook. Alternatively, you can temporarily move it to another contact subfolder as a
backup.
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5. Review the list of contacts again, and complete one of the following options:

Options

Option 1:

If you selected to convert
existing native Outlook
contacts to unshared:

Instructions

You may want to convert your private contacts
back to the native Outlook form. This adds the
Company field back to the Contact form and
removes any Vision business logic.

Open any unshared contacts that should be
shared with Vision, and complete the following:

a. On the Contact form, if there was a value in
the Outlook Company field, another dialog
box opens and you can choose a Vision
client or vendor from the list. If the
appropriate client or vendor is not in the list,
use the Client/Vendor lookup to find it.

b. Complete the other Vision fields, such as
the Business Address, on the Contact
form as appropriate. (The value that was
previously in the Business Address field
will be in the Notes field.)

c. Click the Shared with Deltek bar to share it
with Vision.

d. Save your changes to the contact record. If
the record exists in Vision, it will be detected
as a duplicate when you synchronize.

Option 2:

If you selected to not convert
existing native Outlook
contacts and there are
native contacts that you
want to share with Vision:

Convert the contacts to unshared. To do this,
select the contacts, and click Tools » Convert
to Deltek Form.

Open the contact.

On the Contact form, if there was a value in the
Outlook Company field, another dialog box
opens, and you can choose a Vision client or
vendor from the list. If the appropriate client or
vendor is not in the list, use the Client/VVendor
lookup to find it.

Complete the other Vision fields, such as the
Business Address, on the Contact form as
appropriate. (The value that was previously in
the Business Address field will be in the Notes
field.)

Click the Shared with Deltek bar to share it with
Vision.

Save your changes to the contact record. If the
record exists in Vision, it will be detected as a
duplicate when you synchronize.
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Access and Use Connect for Microsoft Outlook

After you install and configure Connect for Microsoft Outlook, when you open Outlook (with the
Connect for Microsoft Outlook profile), you access Connect for Microsoft Outlook directly. This
section describes the basic components of the main Connect for Microsoft Outlook window.

A

Help » Connect for Microsoft Outlook.

Vision and Outlook Options and Functionality

See the Connect for Microsoft Outlook online help for more detailed information on how to work in
Connect for Microsoft Outlook. On the Outlook menu bar in Connect for Microsoft Outlook, click

[ () Activities - Micrasoft Outiook

Outlook
Menu
Bar

File Edit View

Tools

Actions

Help Adobe PDF

i 2 iEIAN

lew -

g XSS - | N

id | Al Activities =

/1

Opportunity % Vendor "8 Adtivity = Meeting with... * Email to... = Open in Deltek
" Folder List « ||B3 A.. (Filter Applied) [Search Activities Pl
o All Folders 3 |Click here to enable Instant Search |
Vision QAII Outlook ltems * || Owner  Subject Start Date a... End Date ... Type P|F|C F| -
Toolbar =] %ﬁ- Mailbox - || %57 Willia... Appointment Thu 2/24/20... Thu 2/24/2... Phone Call & &
8] Activities &1 Willia... Client Lunch Tue 2/22/20... Tue 2/22/2... Meeting A #
£ Calendar =||| %] willia... Client Visit Sat 2/12/200.. Sat2/12/2.. Mesting A& 2
:: E!Z:Escts -. "l Steve .. Internal Marketin.. Wed 1/12/2... Wed 1/12/... Meeting
@ Deleted ftems (3] | %] Willia... Anderson & Asso.. Tue 1/41/20... Tue1/11/2... Phone Call &
(7| Drafts [1] %2 Willia... Management Me... Fri 7/30/200... Fri7/30/20... Meeting
L:] Inbox (4] %81 Willia.. Seminar Thu 7/29/20... Thu 7/29/2... Continui...
§§J°U"”3| %! Willia... Internal Staff Me... Fri 7/23/200... Fri7/23/20... Meeting
iglunkE-mall * [ % willia... SAME Convention Fri 7/23/200... Fri7/23/20... Meeting
Ij T P&l Willia... SAME Convention Thu7/22/20.. Thu7/22/2... Meeting
] Willia.. Seminar Fri 7/16/200... Fri7/16/20... Continui...
ﬁ Calendar PR Willia.., AIA Convention  Wed 7/14/2.. Wed 7/14/... Meeting
PR Willia.., AIA Convention  Tue 7/13/20.. Tue7/13/2.. Meeting
|8=| contacts SR Willia., ALS Convention  Mon 7/12/2.. Mon7/12/. Meeting
oy 8 Willia... CRM Call Tue 7/6/200... Tue 7/6/20... Phone Call € C
ﬂ i “Ta':' Willia... Seminar Mon 7/5/20... Mon7/5/2... Meeting
;J Notes %] Willia... Design Review Thu 7/1/200... Thu7/,/20.. Meeting 2
"1'|9_' Willia... CRM Call Thu 7/1/200... Thu7//20.. Phone Call A E|
(/E "1'-1' Willia... Internal Marketin... Mon 531/2... #on 5/31/.. Meeting -
Filter &pplied Zlﬁems N All folders are up to date, £3 Connect o Microsoft Exchange ™

Navigation Pane

N

Folder List Icon:
Click it to display
Vision and standard
Outlook folders in the
Folder List view in the
Navigation pane.

~

Outlook
Toolbar

Explorer View:

Displays the records for

the folder that you selected

in the Folder List view.
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Vision Folders and Records

Click the Folder List icon at the bottom of the Navigation pane to display the Vision
Activities, Clients, Opportunities, and Vendors folders and the standard Outlook folders in the
Folder List view.

li») Activities - Microsoft Outlook =l
! File Edit View Go Tools Acions Help Adobe PDF Type a question For help =
@EBak @ @ A *is_glﬂew - @Ry X B R - | B8 W | [ Searchaddressbooks - '@&EQ&QQ@
el @Back @ (A (F (&9 | BY 5T @] | Al Activities =EEY
(& contact | €% Client (¥ Opportunity B Vendor " Activity | Meseting with... * Emailto... » 5= Open in Deltek K
Folder List ) « || 89 Activities (Filter Applied)
All Folders 2 ||[search Activities e vl ¥
2] Al Outlook Items - |Click here to enable Instant Search |
= & Mailbox 21 01 owner | subject Start Date a... |[End Dat... |[Type  [BlF/c/{ =
%’;Ctl'"'tf 5 Willia... this is a jb prop... Mon 2/15/2... Mon 2/1.. Proposal E
dlendar
o Clients & Willia.. Mon 2/15/2... Mon 2/1... Meeting A
- Contacts & Willia... saved but not 5., Mon 2/15/2... Mon 2/1.., Meeting &
@ Deleted Items (3] . Mon 2/1... Meeting
4| Drafts [1] Vision Activities, Clients, . Thu 2/11... 50Q
L] Inbox 4 e
ﬁ]ourna: ] Opportunities, and Vendors . Thu 2/11.. S0Q
(3 Junk E-mail folders, along with standard . Thu 2/11... Proposal
| Motes Outlook folders. - Thu2/11... Proposal 4 R
|85 Opportunities T .. Wed 2/1.. 50Q
L5 outbox & Willia... My Meeting Tue 2/9/201... Tue 2/9/. Meeting & T
LG RSS Feeds "7 Willia... Outlook Meeting Thu 1/28/20... Thu 1/25... Meeting
=7 Sent It
. :} 5;:(;5'::5 . %% Willia.. Outlook Task1  Sun1/24/20... Sun1/2.. Task
3] Tasks T steve .. Clientlunch  Thu3/29/20.. Thu3/29.. Meeting v L
|85 vendors w [ & Steve ... Red Team Review Wed 3/25/2... Wed 3/2... Meeting &
— "1'n" Steve ... Discuss Current.., Wed 3/25/2... Wed 3/2... Meeting P 1
d L % Steve ... Discuss Opport... Mon 3/26/2... Mon3/2... Phone C..C &
e Steve .. Adelphi Review Wed 3/21/2... Wed 3/2... Phane C.., & 1
| Calendar - o
ﬁ & Steve .. User Group Me... Wed 3/21/2... Wed 3/2... Meeting
= - |71 Steve ... meeti Tue 3/20/20... Tue 3/20.. Meeti C
e ﬁ _‘J . 18] Steve .. meeting ue 3,20, ue 3/, ee !ng 2

T

Explorer View:

This displays the records for the
folder that you selected in the
Folder List view (in this example,
Activities).

Folder List Icon

You can share and synchronize records only in the top-level folders in the Folder List pane.
Records that you create in subfolders within the top-level folders, though they have a Shared
with Deltek bar for sharing, do not get shared with Vision when you synchronize.

=  Connect for Microsoft Outlook synchronizes only records in the top-level folders in the Folder
List pane that have the default folder names—Activities, Calendar, Clients, Contacts,
Opportunities, Tasks, and Vendors. Records that you create in folders with names other than
these names do not synchronize.
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Explorer View

When you click a folder in the Folder List view, the folder's records display in the Explorer view on
the right side of the window. For example, when you click the Clients folder in the Folder List
view, a list of Vision clients displays in the Explorer view.

Views: Current, Vision-Specific, Customized, and New

Current View

How the records display in the Explorer view is determined by the current view that you select for
the folder.

To change the current view for a folder, select the folder in the Folder List view, and then from the
Outlook menu bar, click View » Current View.

The Current View menu includes standard Outlook views and Vision-specific views.

(> Clients - Mi t Outlook
1 File  Edi Tools  Actions Help Adobe PDF
| @ Back @~—Tfnange By > Zilsdnew - 23 X -1 All Clients is a Vision-specific
PO - H - - . . .
06 | @ pag  CurrentView |lv AlCients = & | view for the Vision Clients folder.
i <4 AutoPreview i
: & contact 1 = RS e h Contacts [ Email to Contacts &% Open in Deltek _
ey Kpand llapse Groups » Address Cards
. (Eilt AN Search Clients
Folder Li Mavigation Pane 3 Detailed Address Cards R | aren ten Lt v|
All Fold
ik To-Do Bar 3 Phone List parch
QAIIOutIoo Reading Pane » By Category Type Phone Relationship Status
= Q\..{Dr Mailba e SOM  Health Care 2125496400 Existing Active
N i i ompan
G Act Reminders Window Yaomeany ONMI  Health Care 713.736.5400  Prospect Active
Toolbars » By Location 92 HealthCare 7036445800  Existing Active
Status Bar Outlook Data Files 75 Health Care 6173331100  Existing Active
= Customize Current View... M5 Health Care 916.890,9000 Prospect Active
s Health Care  310.667.3294 Active
o == Define Views... -
L_d Inbox 4} PE Health Care 503.234.4559 Farmer Inactive =
55 Joumal R o T T ER  Health Care 4105647810  Existing Active
L-q fu“”f E-mail | |ﬂ(;ﬁ City of Boston  0000BOSTON  Health Care 5176354505  Existing Active

Vision-Specific Explorer Views

The following are Vision-specific views that you can select from View » Current View.

Vision Folder in | Vision-Specific View in

View » Current View

Folder List View

Activities All Activities
Clients All Clients
Contacts All Contacts
Opportunities All Opportunities
Vendors All Vendors
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Customized and New Views

From the Current View menu, you can also select Customize Current View or Define Views to
customize the current view further or to create a new view.

[:ﬂl See the Outlook online help to learn how to create new views or customize current views. On the
Outlook menu bar in Connect for Microsoft Outlook, click Help » Microsoft Office Outlook Help.

Filters and Views

When you work in Connect for Microsoft Outlook, Filter Applied displays in the Connect for
Microsoft Outlook taskbar at the bottom of the screen. An applied filter is part of the Connect for
Microsoft Outlook's normal, internal functionality that you cannot change. These filters are not the
synchronization filters that you create in the Filter Records screen on the Synchronization Control
Panel dialog box.

|4 Shared-Unshared-Mative
| SharePuoint site -

Ll | 3

ij Mail
ﬁ Calendar

CERF N R T Ry

ter Appliec 7 Items

st rtl @ ~ wY * 3] office Comm... “ i~ 2 Microsof...~
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Vision Toolbar

The Vision toolbar in the Explorer view contains buttons that you use to create new Vision
records. The Contact, Client, Opportunity, Vendor, and Activity buttons always display. Other
buttons are context-sensitive and display only when a certain type of record is selected.

The Open in Deltek button displays based on the type of record you select in Explorer view and
the state of the record. Click this button to open the Vision software.

The following screen shot shows the Vision toolbar buttons that display when you select the
Clients folder in the Folder List. These buttons include Contact, Client, Vendor, and so on.

[ Clients - Microsoft Outlook A =T
i File Edit View Go Tools Acdions Help Adobe PDF Type a question For help (=
@Bk @A A& . iEdNew - [ R3 X 5 & - W | G Searchaddressbocks - | @ o B . 14 -
iPd  @Bak @ B &9 &5 @ | A dents N=E T
_>I Contact # Client Opportunity 32 Vendor 18] Activity 18| Meeting with Contacts Email to Contacts Cpen in Deltek -
Folder List « || 82 Clients (Filter Applied) |Search Clients
All Folders E | Click here to enable Instant Search
Vision QA”Q“HOOK Items > |1 name Mumber Type Phone Relationship Status
TOO' bar = ?3& Mailbox - Juli Bertram 4# Anderson & A.. 00ANDERSON  Health Care 212.549,6400 Existing Active
|85] Activities ¢# Anthony Masc... 000MASCOMNI Health Care 213.236.5400 Prospect Active
:@..Ei!iﬂﬂar 3 Atlantic Resea... 0000000192  Health Care 7036445800  Existing Active
_:_='|C ------- tct # BioMed Techn... 0000003425 Health Care 6173331100 Existing Active
=| Contacts
@ Deleted Items (1} L% CALTRANS O3CALTRANS Health Care 9165909000 Prospect Active
|_2| Drafts [1] 3 Calvert Count.., Health Care 3106673294 Active
L:’q Inbox (4} % Cape Cod Dev... 000000CAPE Health Care 508.234.4559 Former Inactive
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Outlook Menu Bar
You can also select Vision and standard Outlook commands from the Outlook menu bar.

The following screen shot shows the submenus and commands when you click the File menu.

r () Clients - Microsoft Outlook ==X 1
I—> I File § Edit View ©Go Tools Actions Help AdobePDF =
2 New b |8 Contact Ctri=N J T W | @Y Search addressbooks  « | (@) EQ “H & B
g Open 4 @ Distribution List Ctrl+Shift+L 3 j _::';ﬁ ;_\i -
Outlook | ClosgalTtems i Folder.. Ctrisshirt+E [T :
Menu Bar & h Contacts [/ Email to Contacts il Open in Deltek  _
A ‘,'_\": Save As.. Mavigation Pane Shortcut...
. (Filter Applied) |Search Clients P
|| save Attachments v |31 Mail Message Ctrl=Shift =M (Filter Applied) _[Searc K:
h
Folder v |E Appointment Cirl=Shift=A oo |
: : Type Phone Relationship Status =
Data File Management... ﬁ Meeting Reguest Ctrl=Shift=Q — - |
5 ; RSOM  Health Care 212.549.6400 Existing Active
ImportandiEport 2 4 Task CUrl=ShIft=K  Fonl Health Care  213.236.5400  Prospect Active
Archive... 1l Task Request Ctrl=Shift<U  jo2 Health Care 703.644.5800  Existing Active
Page Setup » éﬂ Journal Entry Ctrl=Shift=+J 425 Health Care 617.333.1100 Existing Active
j, e __] Note Ctrl=Shift =N AMNS Health Care 916.,590,9000 Prospect Active
= & IntenetF G Health Care 310667.3294 Active
i + nterne ax r+ I+,
& print.. ik APE  Health Care  508.2344589  Former Tnactive 4
Cached Exchange Mode  » | 22| Choaose Form.., IER Health Care 4105647810  Existing Active
Work Offline %} Choose InfoPath Form..,  Ctrl=5hift=T TOM Health Care 617 635 4505 Existing Active
o Outlook Data File.., IDGE  Health Care 6174921200  Existing Active
= : ; IARL Health Care 7046756000 Prospect Active
E% RSS Feeds B et MIN  Health Care 8152451000  Existing Active
f Sent Items A Opportunity PHIS  Health Care 901.546.2589  Existing Active
E% sync Issues [49) 2 yendor CVS  Health Care 7143383000  Prospect Active L]
Tasks . .
8 Vendors =1-.3_- Activity TOM Health Care 7025645710 Existing Active
rrrrr AT TR O OOy LE Health Care 904,741.5400 Farmer Dormant

The following table identifies Vision commands on the menu bar:

Vision Commands in the Outlook Menu Bar | Description

File » New » Use these commands to create a new Vision
= New Client client, activity, opportunity, or vendor.

= New Activity

=  New Opportunity

= New Vendor

File » New » Contacts Use the Contacts command to create Vision
and/or Outlook contacts.

Go » Use these commands to open the Clients,
«  Clients Activities, Opportunities, or Vendors.
= Activities
= Opportunities

= Vendors
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Vision Commands in the Outlook Menu Bar

Actions » Convert to Native Outlook Form

Description

This command displays when you select a
contact record in Explorer View.

Use this command to convert an unshared
contact to the native (standard) Outlook form.
This removes the Vision-specific fields and all
the data contained in them.

You can convert one or more contacts at a
time.

Actions » Convert to Vision Form

This command displays when you select a
contact record in Explorer View.

Use this command to convert a standard
(native) Outlook contact to a unshared contact.

Unshared contacts:

= Contain Vision-specific data fields that
are not available in Outlook (for
example, the Client/Vendor field on
the Connect for Microsoft Outlook
Contact form).

= Are not synchronized with Vision, so
they do not display in Vision. They
display in Connect for Microsoft
Outlook only.

= Can be shared with Vision on a
contact-by-contact basis at any time
by clicking the Share bar for the
contact on the Contact tab in Connect
for Microsoft Outlook.

You can convert one or more contacts at a
time.

Help » Connect for Microsoft Outlook Help

Opens the Connect for Microsoft Outlook help
system, where you find topics on how to use
Connect for Microsoft Outlook.

This help system is accessible when Connect
for Microsoft Outlook is either online or offline.
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Connect for Microsoft Outlook Application States

The following table identifies the various Connect for Microsoft Outlook icons that you see on your
Windows desktop taskbar that indicate the current state of the Connect for Microsoft Outlook
application.

Send/Receive Error - click here @ o 2 Connected to Microsoft Exchange ™

[~ Inbo - Microsoft .. | 100% [ |<< @ la®@® IO HE 152m

Connect for Microsoft Outlook icon
on your Windows taskbar

Connect for
Microsoft
Outlook

Application Menu Items Available When You
State Description Click the Icon

Not Configured Connect for Microsoft Right-click the icon, and select one
Outlook is not configured to | of the following options:
be used in the selected

Outlook profile. = Obtain package — Select this

option to apply the application
configuration.

This menu is available during
initial application confirmation.

It starts the customization
package download and applies
the application configuration.

It can also open the Login dialog
box if the user's credentials are
not supplied.

= Options — Select this option to
edit the proxy settings on the
Connection tab of the Options
dialog box.

= Change credentials — Select
this option to specify the Vision
user credentials on the Login
dialog box.
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Connect for
Microsoft

Outlook
Application Menu Items Available When You
State Description Click the Icon

Online Connect for Microsoft Right-click the icon, and select one
Outlook is running, and the of the following options:
connection with the Vision

server is available. = Synchronize Now — This starts

a synchronization session.

= Show Progress — This opens
or hides the Connect for
Microsoft Outlook
synchronization progress
screen. This option is available
during a synchronization
session.

= Show Control Panel — This
opens the Synchronization
Control Panel dialog box.

= Open Connect for Microsoft
Outlook — This opens Connect
for Microsoft Outlook in the
foreground if it is not your active
application.

= Options — This opens the
Connect for Microsoft Outlook
Options dialog box.

Offline The connection with the Right-click the icon, and select one
Vision server is unavailable. | of the following options:
If a connection to the = Open Connect for Microsoft
computer running the Vision Outlook — This opens Connect
server is not available, for Microsoft Outlook in the
Connect for Microsoft foreground if it is not your active
Outlook switches to offline application.

mode. In offline mode, you
cannot synchronize, change
credentials, or open the
Connect for Microsoft
Outlook Control Panel. The Change button on the
General tab is disabled, and you
cannot change the user
credentials.

= Options — This opens the
Connect for Microsoft Outlook
Options dialog box.

When the connection is
restored, Connect for
Microsoft Outlook
automatically switches to
online mode. Any changes
that you made while a
connection to the server was
not available are
synchronized when you run
a synchronization session.
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Connect for
Microsoft
Outlook
Application
State

Collisions
Detected/

Duplication
Detected/

Deletion
Detected/

Synchronization
Issue

Description

A synchronization conflict or
issue has occurred. The
application is connected to
the Vision server.

See the Resolve Duplicates
and Resolve Conflicts topics
in the Connect for Microsoft
online help for more
information.

Menu Items Available When You
Click the Icon

Right-click the icon, and select one
of the following options:

= Synchronize Now — This starts
a synchronization session. If the
collision is not resolved, the
session ends with the same
collision indicator.

= Show Progress — This opens
or hides the Connect for
Microsoft Outlook
synchronization progress
screen. This option is available
during a synchronization
session.

= Show Control Panel — This
opens the Synchronization
Control Panel dialog box.

= Open Connect for Microsoft
Outlook — This opens Connect
for Microsoft Outlook in the
foreground if it is not your active
application.

= Options — This opens the
Connect for Microsoft Outlook
Options dialog box.

Broken Data
Structure

One of the custom folders
installed by Connect for
Microsoft Outlook has been
removed.

Right-click the application icon and
select Fix integrity to re-install the
data structure.

This removes the current Connect
for Microsoft Outlook data and
reinstalls the data structure.

Run synchronization to download the
data from the server again.
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Uninstall Connect for Microsoft Outlook for a
Single User

This section provides information and instructions on how to uninstall Connect for Microsoft
Outlook. When you uninstall Connect for Microsoft Outlook, all shared-with-Vision data is
removed from your Outlook mailbox.

You uninstall the software:
= If you no longer want Connect for Microsoft Outlook installed on a workstation.
= Before you install a Connect for Microsoft Outlook software upgrade.

= Before you reinstall Connect for Microsoft Outlook.

(;’fg“\ You must uninstall Connect for Microsoft Outlook before you install a Connect for Microsoft
== Outlook software upgrade or before you reinstall Connect for Microsoft Outlook.

If You Use Microsoft Office Desktop Integration (MODI)

If you have Connect for Microsoft Outlook and the Deltek Microsoft Office Desktop Integration
(MODI) modules installed on a workstation and you uninstall Connect for Microsoft Outlook,
MODI may experience errors.

If this occurs, you must log on to Vision and relaunch the MODI installation routine and choose
the option to repair the installation. After the repair is performed, reconfigure the MODI options to
continue using it.

Uninstall Procedure

/1% To prevent loss of data, Deltek recommends that you synchronize Connect for Microsoft Outlook
— and Vision and back up all personal data in Outlook before you remove the Connect for Microsoft
Outlook software from a workstation. These are steps one and two in the below instructions.

To uninstall Connect for Microsoft Outlook from a workstation, complete the following
steps:

1. On the workstation, perform synchronization between Connect for Microsoft Outlook and

Vision. Open Connect for Microsoft Outlook, and click the Synchronization icon in
the taskbar menu that displays by default at the bottom of the Windows desktop.

2. To back up personal data in Outlook, export data to a PST file as follows:
a. From the Outlook application-level menu bar, click File » Import and Export.

b. On the Import and Export Wizard page, select Export to a file from the list and click
Next.

c. Onthe Export to a File page, select Personal Folder File (.pst) from the list, and
click Next.

d. On the Export Personal Folders page, select the appropriate folders that contain
personal data and click Next.
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e. On the next Export Personal Folders page, click Finish.

Close Outlook.

From the Windows Start menu, open the Control Panel, and select Add or Remove

Programs.

5. Inthe Currently installed programs window, click Connect for Microsoft Outlook in the

list of programs, and then click Remove.

6. The Windows prompt allow you to confirm whether or not you really want to remove
Connect for Microsoft Outlook. Click Yes to proceed with the removal.

7. A dialog box displays with the following message:

To avoid data loss, prior to removing the application, make sure to synchronize all
changes to Vision and back up all personal data by exporting to a Personal Folders
file (File » Import and Export » Export to a file » Personal Folder File (.pst)). If
you have done a final synchronization and backed up your data, click Yes to
proceed, otherwise click No and complete those steps first.

After you click Yes to proceed, Connect for Microsoft Outlook is removed from the Add or
Remove Programs window after the software removal is complete.

The following table describes where records reside after you uninstall Connect for Microsoft
Outlook. (Shared means that the record in Connect with Microsoft Outlook is shared with Vision

when you synchronize.)

Records in Connect for Microsoft Outlook

Contacts, appointments, and tasks originally
created in Vision

Where They Reside After You Uninstall

Connect for Microsoft Outlook

They remain in Vision.

They do not appear in standard (native)
Outlook.

Shared calendar items and tasks originally
created in Outlook

They remain in their corresponding folders in
standard (native) Outlook.

They also appear in Vision.

Contacts, appointments, or tasks originally
created in standard (native) Outlook that were
either native or unshared in Connect for
Microsoft Outlook

(a native Outlook contact never acquired
Vision-specific data fields in Connect for
Microsoft Outlook)

They remain in their corresponding folders in
standard (native) Outlook.

They do not appear in Vision.

Contacts that were shared with Vision

They are removed from Outlook.
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Uninstall Connect for Microsoft Outlook Using
Microsoft SMS

You can use Microsoft Systems Management Server (SMS) to remove Connect for Microsoft
Outlook for multiple users.

};‘?\ To prevent loss of data, Deltek recommends that you synchronize Connect for Microsoft Outlook

— and Vision and back up all personal data in Outlook on each workstation before you remove the
Connect for Microsoft Outlook software from workstations. These are steps one and two in the
below instructions.

To uninstall Connect for Microsoft Outlook on multiple workstations with SMS, complete
the following steps:

1. On each workstation for which you are uninstalling Connect for Microsoft Outlook,
perform synchronization between Connect for Microsoft Outlook and Vision. Open

Connect for Microsoft Outlook, and click the Synchronization icon in the taskbar
menu that displays by default at the bottom of the Windows desktop.

2. To back up personal data in Outlook on each workstation, export data to a .PST file:
a. From the Outlook application-level menu bar, click File » Import and Export.
b. On the Import and Export Wizard page, select Export to a file and click Next.
c. On the Export to a File page, select Personal Folder File (.pst), and click Next.
d

On the Export Personal Folders page, select the appropriate folders that contain
personal data and click Next.

e. On the next export Personal Folders page, click Finish.
Close Outlook on each workstation.
Open the SMS management console.

Open the distribution package that you created for Connect for Microsoft Outlook and
select Programs.

6. Inthe programs list, double-click Connect for Microsoft Outlook.

7. Edit the command line with the uninstall syntax.
Example:
msiexec /uninstall "\\fileserver1\Deltek\ConnectForMicrosoftOutlook.msi" /gr
This is the same as Example 3 on page 53.

8. Save the distribution package.

9. Run the advertisement for Connect for Microsoft Outlook.

[:ﬂl For more information, see the topic on how to uninstall a product in the Msiexec command-line
options section of the Microsoft Technet Web site — http://technet.microsoft.com/en-
us/library/bb490936.aspx.
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Connect for Microsoft Outlook Cleanup Utility

Installing Connect for Microsoft Outlook on multiple workstations and connecting to the same user
mailbox on these multiple workstations is not supported. If you attempt to do this, you will receive
the following data structure collision error when you install Connect for Microsoft Outlook to the
same user mailbox on a second workstation and run the Connect for Microsoft Outlook Assistant.

&y Connect for Microsoft Outlook: data structure collision
Another installed instance of Connect for Microsoft Qutlook detected on this

mailbox. Please deinstall it and restart Cutlook.
o NS

To resolve the issue and permanently use Connect for Microsoft Outlook on one
workstation only, complete the following steps:

1. On the workstation that will not be using the Connect for Microsoft Outlook, uninstall
Connect for Microsoft Outlook. This will remove the installation of Connect for Microsoft
Outlook from the mailbox.

2. On the workstation that you plan to use Connect for Microsoft Outlook permanently, run
the Cleanup Utility.
To use the Cleanup Utility, complete the following steps:

1. On the workstation that will permanently use Connect for Microsoft Outlook, close
Connect for Microsoft Outlook.

2. From the Windows taskbar that displays at the bottom of your screen by default, click
Start » All Programs » Deltek » Cleanup Utility.

3. On the Connect for Microsoft Outlook Cleanup dialog box that says this program will
remove data structures installed by Connect for Microsoft Outlook from your Outlook
profile, click Yes.

This removes all data structures installed by a previous installation of Connect for
Microsoft Outlook from your Outlook profile.

Connect for Microsoft Qutlook CleanUp EE

This prograrm will rermove data structures installed by Connect for

! % Microsoft Outlook frorm wour Qutlaok profile. This action may lead to
data loss so use it OMLY after saving your Outlook personal data and
OMLY if installation of new version of Connect for Microsoft Outlook
fails.
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4. On the Choose Profile dialog box, from the drop-down list in the Profile Name field,
select the profile that you used when you installed Connect for Microsoft Outlook.

Chaoose Profile

Profile Mame: |ha|

(=] [ new.

Mew

-

=5

K

] | Cancel ||thiu:uns :=-:=-|

5. If you are prompted for your Outlook/Exchange credentials, enter them and click OK.

Connect to HOIWISIOM AR L wision.dom

==

Connecting to HQIYISIONME L, vision, dom

ser name:

ﬁ cgomez@vision.dom

Password: sssssnns

Remember my password

| ox

Cancel

6. When the command prompt screen displays "The clean up finished" to indicate that the
process completed successfully, press Enter on your keyboard.

B ChUsersymartingriffith\De sktoph\CMO _cleaner.exe
The clean up finished
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7. Launch Outlook, and enter your credentials if prompted for them.

After a short delay, Connect for Microsoft Outlook begins the process of checking the
structure of the mailbox and applying the Vision data structure into the mailbox. Then it
launches the Connect for Microsoft Outlook Assistant to configure the Connect for
Microsoft Outlook software.
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Troubleshooting

Audit Reports

The following Vision reports have a Source column that displays a code to indicate whether
changes were made in Vision or Connect for Microsoft Outlook:

= Client Audit

=  Client Audit Detail

= Contact Audit

= Contact Audit Detail

= Opportunity Audit

= Opportunity Audit Detalil

= Vendor Audit

= Vendor Audit Detail

The possible source codes are:

= DTK — Changes were made in Vision.
=  SNC — Changes were made through synchronization with Connect for Microsoft Outlook.

These reports are located in the Vision software in Reporting.

General Log

View the Log

Use the Feedback tab of the Connect for Microsoft Outlook - Options dialog box to view a general
log that may help with any type of error.

Click the View Log button to open the Log.0000.txt file in Microsoft® Notepad.

% Connect for Microsoft Outlook - Dptions ﬂ
[@ (1 riuality Report
T| | General LUse this form to email issues and bug reports, Attaching a log allows
7 better understanding of the issue, and to address it Faster, The report
@ synchronization does nok conkain personal information,

Comments:

Feadback.

g Connection
F g

?{:‘ﬁ Advanced
@ About

v attach a Lag

Wigw Log. .. | Send Feedback. .. |

[al'd Cancel Gy |
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Email the Log
To attach the log to an email and send the email to Deltek Customer Care Support (or to
whomever you want), complete the following on the Feedback tab:

1. Click the Attach a Log check box.

2. Inthe Comments text box, enter the text for the body of an email.

3. Click the Send Feedback... button to open the Message form, enter the email recipients
in the To and Cc fields, and modify the email message.

4. Click the Send button to send the email message.

Advanced Logs

If you encounter a synchronization problem or error that you cannot resolve, you can send the
Advanced logs to Deltek Customer Care. These advanced logs are enabled by default.

Send the Advanced Logs to Deltek

After you encounter a synchronization problem, complete the following steps on a
workstation:

1. Capture screen shots of the Connect for Microsoft Outlook Synchronization Control Panel
dialog box and the Filter Settings screen, and/or document the settings information and
any other details.

2. Zip the Logs folder in the Connect for Microsoft Outlook Profile directory. This folder
contains the logs for troubleshooting.

Path to the Connect for Microsoft Outlook Profile directory:
=  Windows XP:
%AppData%)\Deltek\Connect for Microsoft Outlook\Profile

(where %AppData% in the path is a system variable for the user's Windows
profile)

This will take you to C:\Documents and Settings\<your
UserName>\Deltek\Connect for Microsoft Outlook.

For example, a Windows user named MaryAnderson would find her logs in
C:\Documents and Settings\MaryAnderson\Deltek\Connect for Microsoft
Outlook\Profile folder.

=  Windows 7 and Windows Vista:
%AppData%)\Deltek\Connect for Microsoft Outlook\Profile

(where %AppData% in the path is a system variable for the user's Windows
profile)

This will take you to C:\Users\<your UserName>\Roaming\Deltek\Connect for
Microsoft Outlook.

For example, a Windows user named MaryAnderson would find her logs in
C:\Users\MaryAnderson\Roaming\Deltek\Connect for Microsoft Outlook\Profile
folder.
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3. Send the following to Deltek Customer Care:
= The zipped file containing the log files from the Outlook Profile directory.
= Screen shots of the filter selections in the Synchronization Control Panel.

= Any other screen shots or other detailed information.

Delete the log files

You can delete the Logs folder to prevent the log files from getting large. Before you delete the
folder, you must exit Outlook. After you delete the folder, the log files are automatically recreated,
and they start recording again.

Vision Data Structure is Inconsistent

Symptoms

When you start Outlook using your Connect for Microsoft Outlook profile, a pop-up message
displays at the application icon informing you that Connect for Microsoft Outlook data structure is
inconsistent and needs to be reinstalled. The application icon is gray, and the only menu
available is Fix integrity.

Cause

Connect for Microsoft Outlook is in the Broken Data Structure state. This situation may occur if
you have completely deleted one of the folders that Connect for Microsoft Outlook uses to store
Vision records from Outlook. Alternatively, Outlook may have exited incorrectly and the data
storage is corrupt.

Solution

To fix the inconsistent structure, complete the following steps:

1. Click the pop-up message to reinstall the Connect for Microsoft Outlook data structure.
Alternatively, right-click the application icon, and select Fix integrity from the contextual
menu.

2. Connect for Microsoft Outlook reinstalls the data structure. You can see all the Vision
folders in the folders list.

If needed, modify the synchronization filters.

4. Run synchronization to download the data from the Vision server.
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Connect for Microsoft Outlook Does Not Start When You
Launching Outlook

Symptoms

When you start Outlook, Connect for Microsoft Outlook does not start. The Connect for Microsoft
Outlook icon does not display in the notification area on your Windows taskbar.

Cause

Outlook has soft disabled the Connect for Microsoft Outlook add-in. Soft disabling occurs when
an add-in throws an unhandled exception in the constructor or the Startup event handler, but the
application does not unexpectedly close.

Solution

Check to see whether or not the Connect for Microsoft Outlook add-in is enabled.

Outlook 2010:
1. On the Outlook toolbar, click File.
2. Inthe Info pane, click Options.
3. Inthe Outlook Options dialog box, click Add-Ins.
4. Ensure that COM Add-ins is selected in the Manage field, and then click Go.
5

On the COM Add-Ins dialog box, select the Connect for Microsoft Outlook check box if
it is not already selected.

6. Click OK.

Outlook 2007:
1. On the Outlook Tools menu, click Trust Center » Add-ins.

2. On the Add-ins screen, ensure that COM Add-ins is selected in the Manage field, and
then click Go.

3. Onthe COM Add-Ins dialog box, select the Connect for Microsoft Outlook check box if
it is not already selected.

4. Click OK.

Outlook 2003:
1. On the Outlook Tools menu, click Options.
In the Options dialog box, click the Other tab.
Under General, click Advanced Options.
In the Advanced Options dialog box, click COM Add-Ins.

On the COM Add-Ins dialog box, select the Connect to Microsoft Outlook check box if
it is not already selected.

6. Click OK.

o~ 0D
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Appendix A: Complete and Incomplete Records
After Synchronization

When you synchronize Connect for Microsoft Outlook and Vision, Vision records are brought into
Connect for Microsoft Outlook as complete or incomplete records.

Complete Records

Complete records match your synchronization filter and are brought completely into Connect for
Microsoft Outlook. All their information displays on the record form.

When you create synchronization filters on the Filter Records screen of the Synchronization
Control Panel, the number of complete Vision records that will synchronize displays in the lower
left corner of the Filter Records screen as the number of record(s) accessible.

# Synchronization Control Panel : Xl

WD | A
Filtet Records | Check Issues Fesolve Conflicks Resolve Confirmn
{41} Duplicates Synchranization

Please, specify the criteria vou'd like to use For determining which Deltek items have to be synchronized with
Connect For Micrasaft Outlook, The Fallowing Filkers are applied to selected categaries and subcateqgories,

Client ({"LinkedToMe'=true AND "Status'="active"))
Ackivities
O 1

2 0 record(s)

oy Client o

= , Match criteria: (& al O any
st 15 recor{% —
L RITHR

7 LinkedToMe = brue i
Contact
5 record(s] W Skatus = Active 1]
# Employee
D @ g record(z)
+ 4 Opportunity
. O 0 record(z)
Displays the
Project
number of O ‘JU record(s)
complete o
'endor o
records to O = 0 record(®) &5 W
synchronize
Remaove local records nok matching filkering criteria

20 record(s) acces% Presets Save Close

Incomplete Records

Incomplete records:

= Do not match your filter, but they synchronize because they are associated with a complete
record that matches your filter.

=  Are records that you have security rights to at least view.
= Are read-only in Connect for Microsoft Outlook, regardless of your security rights.

The associations for incomplete records are not brought into Connect for Microsoft Outlook during
synchronization (to avoid bringing down the entire Vision database into Connect for Microsoft
Outlook).
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In Connect for Microsoft Outlook, incomplete records are identified with “ This record is
incomplete because it did not match your filter.” at the top of their record form.

=
3it)
.-

— “endor Insert Farmat Text Add-Ins

| ﬁﬂ - [M Generali ] Certificates _Sjﬂ ;9% ( 12 [ ﬂPicture = = % 'El Open in Deltek
=| H ;

%' -"J' Details =] &l Fields (ﬁ L4 S Categorize - [ & Meeting with Contacts

. Add ot edit a business card for this
/ Mumber, 0000000001 ‘ et ¥ Prior otk
Marme: &1 Carl Engineers Specialty: |Electrical Engineering ! j

p Recammend

Save & E-mail Meeting  Call Business Spelling .
Close b g Activities - ) Card | ¥ FollowUp~ 8, - L) Email to Contacts
Actions Showy Communicate Dptions Proofing || Connect for Microsoft Cutlook
W This record is incomplete because it did not match your filter, Edit Business Card =

H 3 &« v /¥ Al Carl Engineers 0000000001 - - Yendor -BX

Associated Client: I ﬂ Web Site: I\me.a carl.com
Organization: IBUstUn Architecture I
Contarcts
Adresses Name Title
il I || Thete are no items ta show in this view,

Fhone; Fax

Example:

Scenario:

= You have your synchronization filter set to bring a contact, John Miller, into Connect for

Microsoft Outlook.

=  The opportunity, Bayfield Remodel, is associated with John, but your filter is not set to bring

this opportunity into Connect for Microsoft Outlook.

= You have security rights to modify both John Miller and Bayfield Remodel.

When you synchronize:

= John Miller is brought into Connect for Microsoft Outlook as a complete contact record. All
associations, including Bayfield Remodel display for John on the Contact form. You can

modify John's information on the Contact form.

= Bayfield Remodel is brought into Connect for Microsoft Outlook as an incomplete record. This
means:

On the Contact form for John Miller, Bayfield Remodel displays in the Opportunity grid.

In the Connect for Microsoft Outlook Opportunities folder, Bayfield Remodel displays. On
the Opportunity form for Bayfield Remodel, you cannot modify any of Bayfield Remodel's
information; it is read-only, despite your modify rights.

On the Opportunity form for Bayfield Remodel, in the Contacts association grid, you see
John Miller because his record synchronized as a complete record.

The association grids (Contacts, Clients, Vendors, Activities, Files, and Employees grids)
on the Opportunity form display only the associations for Bayfield Remodel that have
been synchronized as complete records. Any other associations that Bayfield Remodel
has that are incomplete or that were not brought into Connect for Microsoft Outlook at all
(because they did not match your synchronization filter) do not display in the association
grids on the Opportunity form.
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Appendix B: Synchronization Filters

The "Deploy and Configure Connect for Microsoft for the First Time" section of this guide
describes how to enter single filter conditions for determining the records that synchronize
between Vision and Connect for Microsoft Outlook. This appendix provides the following
additional information about filter conditions:

= Default filters (presets)

=  Filter conditions for associated records
= Group filter conditions

= Wildcards (asterisks) for conditions

= [N condition

= Exclusions

= Filters for client hierarchies

Default Filters (Presets)
The following table identifies the default filters that are automatically set up for Vision records.

The LinkedToMe = true condition allows you to synchronize all records that are associated with you.

Vision Top-Level

Record Type Default Filter Condition

Contacts LinkedToMe = true

You are linked (associated) with contact records when your Vision
employee name is entered in the Employees grid on a Contact
record form.

Clients LinkedToMe = true

You are linked (associated) with client records when your Vision
employee name is entered in the Employees grid on a Client record
form.

Opportunities LinkedToMe =true

You are linked (associated) with opportunity records when your Vision
employee name is entered in the Employees grid on an Opportunity
record form.

Activities Two conditions make up an activity record's default condition:

= LinkedToMe=true — Your Vision employee name is entered as
the activity's owner or as an attendee.

= Start Date >= <today's date> — The activity start date is greater
or equal to today's date. Today's date is not dynamic. It is always
the date that you installed Connect for Microsoft Outlook.

Employees Status = Active — All Vision employees with an active status in the
Employee Info Center.
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Vision Top-Level

Record Type Default Filter Condition

Projects None. Only projects that are associated with other synchronized
records are brought into Connect for Microsoft Outlook.

into Connect for Microsoft Outlook as incomplete records. See
Appendix A on page 94 for more information about complete and
incomplete records.

Vendors None. Vendors that are associated with complete records are brought

Delete Default Filters

To delete default filters and any other filters that you create, click the trash can IEI icon beside
the condition.

Check Issues Fesolve Conflicks Resolve Confirmn
{41) Duplicates Synchronization

e

Filter Records

Please, specify the criteria you'd like to use For determining which Deltek items have to be synchronized with
Connect for Microsoft Cutlook, The Following Filkers are applied to selected categories and subcateqories,

Client {{'LinkedToMe'=true AMD 'Status'="Active"))

O Fﬁ Activities

S0 record(s) /
i ] Match criteria: @al O any
15 record -
| % LinkedToMe = true 1]
ﬁ. Contact ) ]
5 record(s) 7 Stakus = Active 1]

# Synchronization Control Panel x|
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Restore Default Filters

To restore default filters, click the Presets button on the Filter Records screen. Then select
Default Filter from the shortcut menu. This resets the default filters for all record types.

¥ synchronization Control Panel

3

Filker Records | Check Issues FResolve Conflicts Resolve Canfirm
(317 Duplicates Synchronization

Specify criteria far determining which Deltek recards will be synchronized with your Outlack, The Fallowing filters are applied ko
the selected categories and subcateqories

Estimated Record Counts Clients ({'LinkedToMe'="true" AND 'Status'="Ackive"))

* Activities

=1 record(s)

&l ef\‘tllents

Makch criteria: (& al O any

15 recol‘l{s] LinkedToMe = true 1
E tact Skatus = Active 1
ontacts
26 record(s]
 Employees
46 record(s)
Opportunities
@ 4’ 18 record(s)
Projects
O ‘.D record(z)
O ml Vendors 5

EEZ () record(s)

Remaove local records nok matching Filkering criceria

Estimated 107 recordfs) accessible Presets i) | Close

Defaulk Filker J

~—_

@ If you customized Connect for Microsoft Outlook through Deltek Global Services, you may see other
options listed in the Presets shortcut menu.

Filter Conditions for Associated Records

You can create filter conditions for records that are associated with top-level records. These are
also known as nested conditions.

You can create conditions for the following associated records:

Top-Level Record

Associated Record

Clients = Activities
= Contacts

Opportunities Activities

Vendors Contacts
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Example

First, you create a filter for clients (a top-level filter) to retrieve all clients who are associated with

you. Then, you create a filter to retrieve only the activities associated with those clients that start
after a certain date.

To create afilter condition for an associated record, complete the following steps:

1. Before you can create a filter condition for an associated record type, you must create a
filter condition for its top-level record (Clients, Opportunities, or Vendors). See steps 8

and 9 in the "Deploy and Configure Connect for Microsoft for the First Time" section on
page 57 of this guide for specific instructions.

The following screenshot displays the LinkedToMe = true and the Status = Active
conditions that were created for Clients (top-level record).

¥ Synchronization Control Panel

Py ._
‘ \a ="
Filker Records | Check Issues Fesolve Conflicks Resalve Confirm
(317} Duplicates Synchronization

Specify criteria for determinin'g' which Deltek records will be synchronized with your Cutlook, The”flollowing filkers are applied to
the selected cateqories and subcategories

Estimated Record Caunts Clients ({'LinkedToMe'="true" AMD 'Skatus'="Ackive"1)

* Activities

= 1 record(s)

Match criteria: & al O dny

-y Clients . _ B
qh& 16 record(s) . LinkedToMe = true [
Contact Stakus = Active ]
ontacts
26 record(s]
™ Employees
@ 46 record(s)
" Opportunities
-..4‘ 18 record(s)

| Projects
D B0 recordis)

ik vendors 5
O ZEE2 1) record(s)

Remove local records not matching Filkering criteria

Estimated 107 recordis) accessible Exclusions. .. Presets Save Close
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After you create a condition for the top-level record, click the plus sign [#l icon beside the
top-level record to expand the record list and display the possible associated records.

¥ Synchronization Control Panel

| 3

Filter Records

Check Issues Fesolve Conflicts

Resolve Confirm
(317

Duplicates Synchronization

Specify criteria for determinin'g' ‘which Deltek recards will be synchronized with your Gutlook, Thé'FoIIDwing filkers are applied to
the selected cateqories and subcategories
Estimated Record Caunts Clienks {'LinkedToMe'="true" AND 'Status'="active"))

mﬂnctivities

“ 1 record(s)

Match criteria: @A O any

HE S

"6 recoEilf_s'j LinkedToMe = true i}
. Cont t Skatus = Active |}
ontacts
26 record(s]

The associated records display below the top-level record. In the following screenshot,

you see the Activities and Contacts check boxes below the Client check box:

¥ Synchronization Control Panel

Es

5 Employees

= iti & v
« Opportunities M-

Remave local recards not matching Ffilkering criteria

D | A

Filter Records

Check Issues Resolve Conflicks

Resaolve Confirm
(317)

Duplicates Synchronization

Specify criteria for debermining which Deltek recards will be synchronized with your Cutlook, The following Filkers are applied ko
the selected cateqaries and subcategories

timated Record Counts Clients {{'LinkedToMe'="true" AMD 'Status'="Active"))

le.nctivities

Clients
16 record(s]

Makch criteria: @ al O any

irkedToMe = trus

Shytus = Active
- Activities
0 record(s)

Contacks
0 record(s)

Contacks
26 record(s)

46 record(s)

18 record(s)

=

Estimated 107 recordis) accessible

Exclusions... Presets Save Close
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3. Click the check box beside the associated record type for which you want to create a
filter. Then, click the name of the associated record beside the check box. In this
example, we clicked the Activities check box and name to create a filter for activities
associated with clients.

® synchronization Control Panel
Filter Recards | Check Issues Fesolve Conflicks Resalve Confirm
(317) Duplicates Synchranization

Specify criteria for determining which Deltek records will be synchronized with your Gutlook, The fbllowing filkers are applied to
the selected categories and subcateqgories

Activities {{'LinkedToMe'="trua" AMND 'Start Date'==05/12/20107) for Clients {{'LinkedTomMe'="trus"
AMD "Status'="Active"))

Estimated Record Counts

Wnctivities =

=1 record(s) Match criteria: & al O any
Eln Ee) 'ﬂ;‘i:::r © |¥ LinkedTaMe = true []

T Stark Date == 08/12/2010 it
-

Contacts
0 record(s)

Contacts
' 26 record(s)

# Employees
] 46 record(s)

iti Y
" Opportunities e

18 record(s) :I

Remove local records not matching Filkering criteria

Estimated 107 recordis) accessible Exclusions, .. | Presets | Save | Close |

4. In the filter criteria pane, click the Add a condition icon to open the Connect for
Microsoft Outlook Filter — Edit Criterion dialog box. Select a field, condition, and value for
the association record filter and click OK.

. Connect for Microsoft Dutlook Filter - Edik Crikeri E El

Figld: Condition: Yalue:

| = =

(a4 Cancel I
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5. Repeat step 4 to create additional conditions for the associated record.

The filter conditions that you create display in the filter criteria pane. This example
displays the filter condition to retrieve my activities that have a start date that is greater
than or equal to 08/12/2010.

® synchronization Control Panel
Filter Records | Check Issues FResolve Conflicks Resolve Confirm
(317) Duplicates Synchranization

Specify criteria for determining which Deltek records will be synchronized with your Gutlook, The Following Filkers are applied ta
the selected categories and subcateqgories

Estimated Record Counts Activities {{LinkedToMe'="trug" AMND 'Start Date'>=08/12/2010)) for Clients {('LinkedToMe'="trus"

AMD "Status'="Active"))
Fiy Activities =
LLT) 1 record(s)

Match criteria: & al O any

-3 Clients — _ )
=] % L6 records) LinkedTaMe = true ]

| Start Date == ogf12/z010 it

» Contacts

0 record(s)
s
| S
- Opportunities T

18 record(s) _ﬂ

Remove local records not matching Filkering criteria

Estimated 107 recordis) accessible Exclusions, .. Presets Save Close
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6. In the filter criteria pane, select the Match criteria setting as follows:

= If you enter more than one filter, select All (AND-based) if you want only associated
records that match all of the conditions to be synchronized.

= If you enter more than one filter, select Any (OR-based) if you want associated
records that match any one of the filter conditions to synchronize; associated records
do not have to meet all the filter conditions.

® synchronization Control Panel E3

e

Filter Recards

Y

. Y

Check Issues Resolve Conflicks Resolve Confirrm
(317} Duplicates Synchronization

Specify critetia for determining which Delkek records will be synchronized with your Outlook, The Following filkers are applied ta
the selected categories and subcategories

Estimated Record Counts Activities (('ILiled_ToWeE"true" AMD 'Start Date'==08{12/2010%) for Clients {{'LinkedToMe'="true"
AMD "Stakus'="ackive"))
|
Activities O ——
e
‘1 record Makch criteria: & al O any /
#-4 Clients - —
=] 16 record(s) LinkedToMe = trug ]

|"¥ Start Date »= ogf12/z010 it

Contacts
“"0record(s)

Contacts
26 record(s)

¥ Employees —
[ 46 record(s)

- Opportunities 5 W
18 record(s) _ﬂ

Remave local recards nat matching Filkering criteria

Estimated 107 recordis) accessible Exclusions, .. | Presets | Save | Close

7. When you finish creating filter conditions click Save on the Filter Records screen.

o | =  On the Filter Records screen, when you clear a top-level record check box to remove the filter
conditions, any filter conditions for associated records are also removed.

When you create two filter conditions for the same record type, but one condition is at the top
level and the other is at the associated record level, the conditions are combined as an OR
statement. For example, if the top-level filter for contact records is set to contacts who are
associated with me, and the filter for contacts who are associated with top-level customer
records is set to all contacts, then the filters return contacts associated with me OR contacts
associated with any customer that match the customer record top-level filter.
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Group Filter Conditions

You can create filter condition groups that are comprised of conditions within a condition. These
are also referred to as nested conditions. You can create an unlimited number of condition groups
and add an unlimited number of single filter conditions to a condition group.

#.] To create filters that mix AND and OR conditions, you must use a group condition.

An example of a group condition for Opportunities:
Status = Active AND (Principal = Emily Davisson OR Revenue > 1000000)

This statement gives you all active opportunities where Emily Davisson is the principal or the
revenue is greater than $1,000,000.

The following screenshot displays this example after you create the filter conditions:

& synchronization Control Panel <]

9 | A

Filker Records | Check Issues Resolve Conflicks Resole Zonfirm

{317) Duplicates Synchronization

Specify criteria For determining which Deltek records will be synchronized with vour Outlock, The follawing Filkers are applied to
the selected categories and subcategories

- Opportunities ({'Status="fctive" AND (‘Principal="Emily Jane Davisson" OR
Estimated Record Counts Revenue'>1000000,000000}7)

o Activities il

* Orecord(s) Match criteria: & al O any Match criteria; Q3 ol & any
ar E?::::;;] W Status = Ackive ] W Principal = Emily Jane Davissan 1l
=) (several nested criteria) fl ¥ Revenus > 1000000.000000 T
1 Contacts
26 record(s)

& Employees

i
o a4 - |
=0 wiy Vendors 1 4 ¥ 5

EEZ () record(s) =

Remove local records not matching Filkering criteria

Estimated 107 record(s) accessible Exclusions. .. | Presets Save Close

An example of a group condition for Clients:

(Status = Active AND Type = Healthcare) OR (Status = Active AND Primary Address
Indicator = True AND Primary Address State = CO)

This statement gives you all active customers that have a customer type of Healthcare or
have a primary address in Colorado.
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To create a group condition, complete the following steps:

The opportunity filter example that returns opportunities with an active status, where Emily

Davisson is the principal or the revenue is greater than $1,000,000 is illustrated in the following
instructions.

1. Inthe pane on the left side of the Filter Records screen, select the check box for the type
of Vision record for which to create a group condition. Then click the check box name to

highlight the check box name and display the Match criteria: All and Any setting in the
filter criteria pane.

¥ synchronization Control Panel

'\

D | A

Filter Recards

Check Issues FResolve Conflicks Resolve Confirm
(317} Duplicates Synchronization
Specify criteria for determining which Deltek recards will be synchronized with yaur Outlook. The Fallowing filkers are applied ta
the selected categories and subcategories
Estimated Record Counts Opportunities (ALL)

" record(s) Match criteria: & al O any

Contacts
aﬁ 0 record(s)

s Activities il

Contacts
26 record(s]

¥ Employees
e 46 record(s)

Projects
D B0 recordis)

el vendars 5 W
O ZEEZ 0 record(s)

Femove local records not matching Filkering criteria

Estimated 128 recordis) accessible Exclusions. .. | Presats | Save | Cloze |

2. Inthe filter criteria pane, click the Add a condition icon to open the Connect for
Microsoft Outlook Filter — Edit Criterion dialog box. Enter a filter condition, and click OK.

In this example, we enter a condition that returns all opportunities with an active status.

@ Connect for Microsoft Outlook Filter - Edit Crite ) x|

Field: Condition: Yalue:

IStatus j |= j I.ﬁ.ctive j
Ik Cancel I
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® Synchronization Control Panel

‘ Filter Records

D

(317

Specify criteria for determining which Deltek records will be synchronized with vour Gutlook, The Following filkers are applied to
the selected cateqories and subcategories

Opportunities {'Status'="activa")

Estimated Record Counts

@ &

B S

big

a Activities
- O record(s)

» Contacts
D record(s)

Contacts
26 record(s)

Employees
46 recort{s)

DOpportunities
39 record(s)

Projects

o ‘.0 record(s)

=0

ly Wendors
EEEZ 1) record(s)

[ |

Match criberia: (&0 Al

s

kst

Check Issues Fesolve Conflicks

Resalve
Duplicates

Caonfirm
Synchronization

Status = Active

O any

Remove local records not matching Filkering criteria

Estimated 128 records) accessible

Exclusions. .. | Presets | Save | Clase: |

In this example, we leave the Match criteria setting at All (AND-based). This means all
single conditions in this column must be met. In this example, we have only one filter

cond

ition.

In the filter criteria pane, click the Add group of conditions icon

A (several nested criteria) folder displays in the filter criteria pane.

® synchronization Control Panel

Filker

| D

£

Records
(317)

Specify criteria for determiniﬁé wihich Deltek records will be synchronized with your Outlook. The 'I:"ollowing filkers are applied to
the selected categories and subcategories

Cpportunities ({'Skatus'="active" AND ALL))

Estimated Record Counts

g
&
&
-

Uas

=0

A

e Activities
~ O record(s)

Contacts
0 record(s)

Contacts
26 record(s)

"

Employees
46 record(s)

, Opportuni
39 record(s) :

Projects
0 record(z)

i endors
ZEZ 0 record(s)

-

Check Issues FResolve Conflicks

IMatch criteria:

Resolve
Duplicates

Confirm
Synchronization

®@al

Stakus = Active

= (several nested criteria)

Qany

Remove local records not matching filkering criteria

Estimated 125 record{s) accessible

Exclusions. .. Precets Save Close
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4. Click the (several nested criteria) folder to display a second column on the right side of

the filter criteria pane that displays the Match criteria: All and Any setting and the

and icons. In this second column, you add single or group conditions that make up a

group condition.

® Synchronization Control Panel

D

P y
L

Filker Records | Check Issues Fesolve Conflicks Resalve Caonfirm
(317} Duplicates Synchronization

|

Specify criteria for determinin'g'which Deltek records will be synchronized with your Cutlook, The'fbllowing filkers are app

Second column
where you enter a
group condition

the selected cateqories and subcategories

Estimated Record Counts Opportunities {'Skatus'="active" AND ALLY)

o | /
THEI:I\'II:IES

~ Orecord(s) Match criteria: @Al O any { Match criteria: O AL (& any

v

& Contacts W Status = Active i

O record(s)
Contacts
@ 26 record(s)

¥ Employees
[ 46 record(s)

:'uﬁ (several nested criteria) ]

-4 Dpportunities
i 39 record(s)

Projects
D 0 recordis)

wily Yendors s ¥
EEZ 1) record(s) I—

N

=0

Remove local records not matching Filkering criteria

Estimated 128 records) accessible Exclusions. .. | Presets | Save Close |

5. Inthe second column, click the Add a condition or Add group of conditions
icons to open the Connect for Microsoft Outlook Filter — Edit criterion dialog box and add
a filter condition. Click OK to save it and return to the filter criteria pane.

In this example, we click the Add a condition icon, and enter a condition to return
opportunities where Emily Jane Davisson is the principal.

# Connect for Microsoft Dutlook Filter - Edik Crit ! ) x|

Field: Condition: Walue:

IF'rinn:ipaI j |= j IEmiI':.f lane Davissan j
(04 Zancel I
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6. Repeat step 5 to enter another filter condition.

In this example, we enter another single condition to return opportunities that have
revenue greater than $1,000,000.

& Connect for Microsoft Outlook Filter - Edik Crik ) x|

Field: Condition: Yalue:

IRevenue j I = j I 1000000

i Cancel |

7. Inthe group condition pane on the right side of the Filter Records screen, select the
Match criteria setting for the group condition.

In this example, we select Any (OR-based), so that opportunities with either Emily as the
principal or revenue greater than $1,000,000 are returned by the synchronization filter.

Notice the complete condition statement at the top of the filter criteria pane is:

Opportunities (('Status'="Active" AND ('Principal'=Emily Jane Davisson" OR
‘Revenue">1000000.000000)))

Between the single filter condition in the first column and the group condition in the

second column is an AND operator.

¥ Synchronization Control Panel itari i
Complete o SomElle iz o el e The Match criteria setting
C;)r][dltlont \_D A for the items within the
statemen : L. .
Check Issues Fesolve Conflicts Resalve Confirm group condition is Any
(317} Duplicates Synchronization

iteria for determining which Deltek records will be synchropiged with vour Gutlook, The following filkers are applied ta
& celected categories and subcakegories
Opportunitizs ((°Stakus'="active" AMD ('Principal'="Emily Jane Davisson" OR
‘Revenue'=1000000, 000000737

Estimated Record Counts

s Activities = /
~ 0 record(s) Match criteria: Al 0 any Match criteria: O3 Al (2 Any
o Contacts W Status = Ackive [ % Principal = Emily Jane Davisson T
0 record(s) | i
7 (several nested criteria) Ml 7 Revenue > 1000000.000000 i
Contacts
26 record(s]

¥ Employees
] 46 record(s)

.4 Dpportunities
i 18 record(s)

Projects
D 0 record(s)

et
*
kst
!

O iy endors

ZEEZ 1) record(s)

b

Remove local records not matching Filkering criteria

Estimated 107 recordis) accessible Exclusions. .. | Presets | Save | Close |

8. When you finish adding conditions for the group condition, click Save.
9. Inthe group condition column (second column) on the filter criteria pane, when you click

the Add group of conditions icon, a third column displays. In this column, enter
another set of conditions.
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The operator between each column of conditions is AND.

' Synchronization Control Panel [ %}
| D | A
| Filter Records | Check Issues FResolve Conflicks Resolve Corfirm
{317) Duplicates Synchronization
Specify criteria For determining which Deltek records will be synchronized with your Outlook, The Follawing Filters are applied ta the selected categories and
subcategories
Estimated Record Counts Opportunities ({'Status'="Active" AMD {Principal'="Emily Jane Davisson" OR 'Revenue'>1000000.000000 OR ALLYY
#-% Clients -l
= 16 record(s) b~ ter (/ iter \
Match criteria: @ al O any Match criteria: O al & any Match criteria: Oy Al & any
= Activities — I — [—
g record(s) | % Status = Active Tl W Principal = Emily Jane Davisson | |
@._.Eontacts |) {several nested criteria) | | W Revenue > 1000000,000000 | |
0 record(s) 7 {several nested criteria) | |
1 Contacts
26 record(s)
# Employees
@ 46 record(s)
| Projects e 5 ¥
a ¥ nip— = 4 / \ ) i
- N
Remove local records nat matching filkering criteria /
el
Estimated 128 recordis) accesd Exclusions... Presets | Save | Close |

Click the Add group of
conditions icon.

Wildcards (Asterisks) for Conditions

For text fields such as the contact First Name, Last Name, and Email fields, when you enter a
condition on the Connect for Microsoft Outlook Filter — Edit Criterion dialog box, you can use an
asterisk (*) as a wildcard character to represent any pattern. You can place an asterisk anywhere
in the Value field and use as many asterisks as you need in the field.

For example, you could enter a condition for email addresses to include only email addresses
with "@deltek.com” in them. To do this, enter *.deltek.com in the Value field for the contact
Email field:

® Connect for Microsoft Dutlook Filter - Edit Criterion

Field: Condition: Yalue;

IEmaiI j |= j I*.deltek.cnm

o Zancel I
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IN Condition

When you create a condition for a drop-down list field or a lookup field, you can choose one or
many items in the value field.

To choose one value in the Value field on the Connect for Microsoft Outlook Filter — Edit Criterion
dialog box, select = (equal) or <> (except) in the Condition field.

* Connect for Microsoft Dutlook Filter - Edit Criterion
Field: Condition: Yalue;

IStatus j |=

To choose multiple values in the Value field on the Connect for Microsoft Outlook Filter — Edit
Criterion dialog box, select IN in the Condition field.

& Connect for Microsoft Dutlook Filter - Edit Criterion

Field: Condition: Yalue;

IStatus j IIN j 2 item(s) selected j

[¥] Active
Exclusions

When you delete a shared-with-Vision contact in Connect for Microsoft Outlook, you receive the
following Confirm Removal dialog box.

Confirm Removal Ed |

& Are you sure ol would like to deleke this Contact from Delkek and
) ;‘I Cutlooky Click es ko delete the Contact from both applications.
= lick. Mo ko remove the Contact From the Conkact Filker,

Yes | Mo I Cancel

= If you click Yes in the Confirm Removal dialog box, the contact is deleted from Connect for
Microsoft Outlook and Vision when you synchronize.

= If you click No in the Confirm Removal dialog box, the contact is deleted from Connect for
Microsoft Outlook, but it remains in Vision. It also becomes an exclusion to the
synchronization filter. This means it will not be synchronized and brought back into Connect
for Microsoft Outlook even if the contact matches your synchronization filter.

If you change your mind in the future and you want the contact to be synchronized with Connect
for Microsoft, you can remove the contact from the exclusion list.
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To remove a contact from the synchronization exclusion list, complete the following steps:

1. On your Windows task bar, right-click the Connect for Microsoft Outlook application
icon, and select Show Control Panel.

On the Filter Records screen of the Synchronization Control Panel dialog box, click the
Exclusions button.

@ synchronization Control Panel

b

Y

Filker Records | Check Issues Fesolve Conflicks Resolve Confirm
(317) Duplicates Synichronization

Specify criteria For determining which Delkek recards will be synchronized with vour Outlook. The Fallowing Filters are
applied to the selected categories and subcateqgories

Estimated Record Counts

%I Activities !

= 1 record(s)

#-4 Clients
19 record(s)

Contacks
27 record(s)

# Employees
@ 46 record(s)

..,‘d Opportunities

18 record(s)
1 & | Projects =
M Rremave lacal records not matching filkering criteria
e
Estimated 111 recard(s) accessible < Exclusions. .. \ Presets | Save | Clase |
P
————

3. Onthe Synchronizations exclusion dialog box, select the contact that you want to remove
from the exclusion list and click Delete.

When you delete the contact from the exclusions list, the contact will be uploaded to

Connect for Microsoft Outlook the next time you synchronize if the contact matches your
synchronization filters.

® synchronization exclusions

ETim Brown

Delete Clear &l Close
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Filters and the Vision Client Hierarchy Feature

When you create a filter condition that brings a client into Connect for Microsoft Outlook that is in
a Vision client hierarchy, all other clients in that hierarchy (above and below that client) are
downloaded as one of the following:

= Complete records if you have view rights to them, and they match your client filter.

= Incomplete records if you have view rights to them, and they do not match your client filter.
(You can open the record and see some information such as the notes, but the association
grids are incomplete.)

= Client name and number only if you do not have view rights. When you click the Client
Hierarchy button (on the Client form) for one of the clients that you have security rights to,
you see this record in the list. However, if you try to open the record, you receive a message
stating that you do not have rights.

[l;[l See "Appendix A: Complete and Incomplete Records After Synchronization" on page 94.

For more information about the client hierarchy feature, see the Vision online help. Open the help
Contents tab, and then click the following books: Info Center » Client Info Center » Client
Hierarchy.
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Appendix C: Synchronization Schedules

When you open Outlook for the first time after you install Connect for Microsoft Outlook and you
run the Connect for Microsoft Outlook Assistant, you choose whether or not to schedule
automatic synchronization between Connect for Microsoft Outlook and Vision. You make this
selection on the Synchronization tab of the Connect for Microsoft Outlook — Options dialog box.

% Connect for Microsoft Dutlook - Options ; ﬂ
U Q —Autorun
TI General ¥ schedule an automatic synchronization interval:
1
Synchronization Frequent J Rare
3 Once an Hour
L Feedback
Mext synchranization will occur Wednesday, February 03, 2010 ak 11:

[% Connection ¥ show progress during automatic synchronization
.=

O 6 Advanced

Show Control Panel, ..

K, Cancel apply

Manual Synchronization

If you do not choose to synchronize automatically, you run the synchronization manually as
needed at any time.

To perform a manual synchronization, complete either of the following:

= Right-click the Connect for Microsoft Outlook icon on your Windows taskbar, and then
click Synchronize Now!.

= Left-click the Connect for Microsoft Outlook icon on your Windows taskbar.
Synchronization starts immediately.

Automatic Synchronization

For automatic synchronizations, you select the synchronization frequency — once a week, once a
day, twice a day, or once an hour on the Synchronization tab of the Connect for Microsoft Outlook
— Options dialog box.
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Synchronization Timer

For automatic synchronizations, the synchronization timer starts at the end of each
synchronization, starting with the initial synchronization that takes place after you configure the
Connect for Microsoft Outlook for the first time.

If Connect for Microsoft Outlook is not open at the time of the next scheduled synchronization
interval, it waits for the full interval before checking to synchronize again.

If you perform a manual synchronization in between the scheduled synchronization interval, the
next synchronization is scheduled to start at the scheduled interval based on the time that the
manual synchronization finishes.

Example

You configure Connect for Microsoft Outlook to synchronize hourly and the initial synchronization
ended at 3:35 PM. The next automatic synchronization is scheduled to start at 4:35 PM.

At 4:35 PM, synchronization begins; it finishes at 4:40 PM. The next synchronization is scheduled
for 5:40 PM.

= If you close Connect for Microsoft Outlook after the synchronization completed at 4:40 PM,
no synchronization would occur at 5:40 PM (and 6:40 PM, and so on) because Connect for
Microsoft Outlook is not open.

= If you open Connect for Microsoft Outlook again the next morning at 8:00 AM, another
synchronization starts at 8:40 AM. It resumes where the timer left off at 40 minutes past the
hour.

= If you perform a manual synchronization at 9:15 AM (in between the automatically scheduled
synchronization interval), and the synchronization finishes at 9:20 AM, the next
synchronization is scheduled to start at 10:20 AM.

Automatic Synchronization Has Stopped Completely

If you rely solely on automatic synchronization and you turn your workstation off at the end of the
day, it is possible that with a synchronization interval other than hourly, you will eventually prevent
synchronization from occurring. This happens because the synchronization will be scheduled to
occur outside normal working hours when your workstation is turned off. When this occurs,
perform a manual synchronization to resolve it.

Change Synchronization Settings

To change synchronization settings at any time after you use the Connect for Microsoft
Outlook Assistant during the initial installation, complete the following steps:

1. Onthe Windows taskbar, right-click the Connect for Microsoft Outlook icon and click
Options.

2. Onthe Connect for Microsoft Outlook — Options dialog box, click the Synchronization tab.
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Appendix D: Vision Records and Fields in
Connect for Microsoft Outlook

The following tables identify the Vision records and fields that appear in Connect for Microsoft

Outlook.

Activity Record

The following Vision Activity fields appear in Connect for Microsoft Outlook:

Vision Activity Field/Grid

Connect for Microsoft Outlook
Field/Grid

Connect for Microsoft Outlook

Form

Subject Subject Activity, Task, and calendar item
Location Location Activity and calendar item

Type Type Activity, Task, and calendar item
Priority Priority Activity and Task

Completed check box

Completed check box

Activity and calendar item

the Outlook Ribbon

Completed check box % Complete Task
Private check box Private check box Activity
Private check box Private icon in the Options group on Task

Client

Client

Activity, Task, and calendar item

Primary Contact and/or
Contacts

Primary Contact field and/or Contacts
grid

Activity, Task, and calendar item

Opportunity Opportunity Activity, Task, and calendar item
Project Project Activity, Task, and calendar item
Activity Owner Owner Activity and Task

Activity Owner Employees Calendar item

CreatedBy CreatedBy Activity

Start Time (date and time) Start Time Activity and calendar item

End Time (date and time) End Time Activity and calendar item

Start Time (date) Start Date Task

End Time (date) Due Date Task
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Vision Activity Field/Grid

Reminder check box

Connect for Microsoft Outlook
Field/Grid

Reminder check box

Connect for Microsoft Outlook

Form

Activity and Task

Reminder amount and
minutes, hours, or days

Reminder amount and unit of time

Activity and Task

Reminder amount and
minutes, hours, or days

Reminder amount of time in the
Options group on the Outlook Ribbon

Calendar item

All Day Event check box

All Day Event check box

Activity and calendar item

Show Time As

Show Time As

Activity

Contacts grid

Contacts grid

Activity

Employees Employees Task and calendar item
Attendees grid Employees grid Activity
Notes text box Notes text box Activity

Notes text box

Description text box

Task and calendar item

Recurring Activity

Recurring

Task and calendar item

Recurrence Type

Recurrence

Task and calendar item

Pattern

Recurrence Pattern

Task and calendar item

Recurrence End

Recurrence Range End

Task and calendar item

Client Record

The following Vision Client fields display on the Client form in Connect for Microsoft Outlook:

Client Field/Grid Name

Name

Number

Client check box

Vendor check box

Parent

View Client Hierarchy

Addresses

Phone
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Client Field/Grid Name

FAX

Minority Status check boxes — Disadvantaged Business, Small Business, Veteran Owned Small
Business, Disabled Vet. Small Business, Minority Business, Woman Owned, HBCU, and Alaska
Native

Specialty

Prior Work check box

Recommend check box

Type

Status

Relationship

Website

Aliases grid

Activities grid

Files grid

Contacts grid

Opportunities grid

Projects grid

Employees grid

Contact Record

The following Vision Contact fields display on the Contact form in Connect for Microsoft Outlook:

Contact Field/Grid Name

First Name, Middle Name, and Last Name — the Full Name field in Connect for Microsoft Outlook

Preferred

Client/Vendor

Title (job)

Email

Business Phone
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Contact Field/Grid Name

Business Fax

Mobile

Home

Pager

Client Address — Address 1, Address 2, Address 3, Address 4, City, Country, State/Province, and
ZIP/Postcode

Other/Home Address — Address 1, Address 2, Address 3, Address 4, City, Country, State/Province, and
ZIP/Postcode

Mailing check box for the address fields

Notes text box

Activities grid

Opportunities grid

Employee grid

Projects grid

Files grid

Opportunity Record

The following Vision Opportunity fields display on the Opportunity form in Connect for Microsoft
Outlook:

Opportunity Field/Grid Name

Name

Number

Description

Organization

Primary Client

Primary Contact

Principal

Project Manager

Supervisor
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Opportunity Field/Grid Name

Regular Project

Status

Stage

Type

Source

Date Open

Date Closed

Estimated Start

Estimated Completion

Revenue

Probability

Weighted Revenue

Clients grid

Employees grid

Files grid

Activities grid

Contacts grid

Vendors grid

Vendor Record

The following Vision Vendor fields display on the Vendor form in Connect for Microsoft Outlook:

Vendor Field/Grid Name

Number

Name

Associated Client

Organization

Addresses — Address 1, Address 2, Address 3, Address 4, City, Country, State/Province, and ZIP
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Vendor Field/Grid Name

Phone

FAX

Minority Status check boxes — Disadvantaged Business, Small Business, Veteran Owned Small
Business, Disabled Vet. Small Business, Minority Business, Woman Owned, HBCU, and Alaska Native

Status

Specialty

Specialty Description text box

Web Site

Prior Work check box

Recommend check box

Aliases grid

Opportunities grid

Files grid

Contacts grid

Projects grid
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